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Introduction
Provides an overview of StarTeam product installation.

Included in this Installation Guide
This Borland StarTeam release provides updates to the CPC, Web Client, Server, and Command Lines, and
many other components. Refer to the appropriate release notes for details on What's New for each component.
Although in some cases, you may be installing products from a previous StarTeam release, this document
provides installation instructions for the following StarTeam products:
•
•

Server (for Windows and Linux)
StarTeamMPX (for Windows and Linux) including:
•
•
•

•
•
•
•

StarTeamMPX Event and File Transmitters (installed with the Server )
StarTeamMPX Message Broker
StarTeamMPX Cache Agent

Cross-Platform Client
StarTeam Web Server
Layout Designer
Workflow Extensions including:
•
•
•

Extensions
Workflow Designer
Notification Agent

In addition, this manual covers:
•
•
•
•

Database configuration for Microsoft SQL Server and Oracle.
Upgrading server configurations.
Supporting software installation and configuration.
Data locations.

Accessing Products and Installation Instructions
The following sections provide a summary of products, where you can get them, and where you can find the
installation instructions for them.

Products Included with Enterprise Licenses
The following table provides a summary of Borland StarTeam products that come with the Enterprise license.
The installation instructions for some products are not in this consolidated installation guide, but are located
in the respective guide of that product.
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Product
Server (12.5)

Platform
32-bit application for
Windows Server 2003
SP2/2003 R2 SP2; 32-bit
application will run on 64-bit
version of these operating
systems.

A Server stores artifacts (files,
change requests/defects, tasks, and
topics) for clients. A server can
support one or more server
configurations on the same computer.
Install Server on a computer that is
accessible to all users. The server is
32- and 64-bit application for
translated into English, French,
Windows 2008; 64-bit
German, and Japanese. However the
application for Windows 2008
12.5 installation guide is only in
R2
English.

StarTeamMPX Message Broker 32-bit application for
(12.5)
Windows Server 2003
SP2/2003 R2 SP2; 32-bit
application will run on 64-bit
version of these operating
systems.
64-bit application for
Windows 2008

Cross-Platform Client (12.5)

Description

Message Broker pushes information
from the server to clients. Usually an
administrator sets up a cloud of
Message Brokers to improve server
performance for users in diverse
geographic locations. One
(sometimes two) root Message
Brokers are set up for the server,
usually on the same computer or in
a network-near location. For Express,
MPX is probably not needed.

32-bit applications for:
Windows XP Professional
SP3; Windows Vista SP1:
Windows 7

The Cross-Platform Client (CPC) is
the most used client and provides
users with access to all the artifacts
on the server.

RedHat Enterprise Linux
(WS) 5.1

The CPC is translated into English,
French, German, and Japanese, but
the installation guide is only in
English.

Solaris Sparc 10

Installation
Guide
Yes

Yes

Yes

Universal Edition for
platforms that run Java
Web Server (12.0)

64-bit application for
Windows 2008 R2 SP1

LDAP Quickstart Manager (2009) 32-bit application for
Windows XP Professional
SP3; Windows Vista SP1

10
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The Web Server makes it possible
Yes
for users to access the server from
their browsers using the Web client.
The client is a thin client, primarily for
users who do not check files in and
out often. For example, a quality
assurance engineer using change
requests most of the day can access
the server easily from a simplified
interface without installing any
applications.
The Server can provide password
Yes
authentication via a directory service,
such as Active Directory. Use LDAP
Quickstart Manager (QSM) to add
users to the server, along with their
distinguished names (DN) (needed
for authentication) and other user
information.

Product
Layout Designer (2009)

Platform

Description

32-bit application for
Windows XP Professional
SP3; Windows Vista SP1

Use Layout Designer to create forms
for artifacts, such as change
requests. This allows you to put the
most important properties on the first
tab, etc. With the web client and an
Enterprise Advantage server, a
Layout Designer form works with
workflow. This is not true of the
Cross-Platform Client where Layout
Designer's use is only for form
building.

UNIX; tested on RedHat
Enterprise Linux (WS) 5.1

Installation
Guide
Yes

This product is translated into
English, French, German, and
Japanese.
SDK (12.5)

32-bit for Windows and UNIX
No
The SDK is cross-compiled so that it
platforms; 64-bit runtime for
can be offered both as a Java and a
Windows Server 2008
.NET application. The full SDK is
used by developers to create
additional applications that use the
Server. It is only 32-bit.
Usually, the SDK runtime is installed
with clients automatically so it can be
used by them to access the server.
Occasionally, you may need to install
the runtime.
This product is translated into
English, French, German, and
Japanese.

Products Included with StarTeam Enterprise Advantage
Licenses
In addition to the products included with StarTeam Enterprise licenses, StarTeam Enterprise Advantage licenses
also include the products listed in the table below. The installation instructions for some products are not in
this consolidated installation guide, but are located in the respective guide of that product.
StarTeam Product
Cache Agent (12.5)

Platform

Description

Consolidated
Installation Guide

A root Cache Agent monitors
Yes
the server's repository for file
content and object properties.
Via Message Brokers, the data
is pushed to remote Cache
Agents that are network near to
64-bit application for Windows members of dispersed teams,
improving the speed with which
2008
users access the data they
need.
32-bit application for Windows
Server 2003 SP2/2003 R2
SP2; 32-bit application will run
on 64-bit version of these
operating systems.
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StarTeam Product
StarTeam Extensions (12.0)

Workflow Designer (12.0)

Platform

Description

32-bit applications for:
Windows XP Professional
SP3; Windows Vista SP1:
Windows 7

StarTeam Extensions (STE)
enables clients to take
advantage of workflow and
custom toolbar applications.The
STE files must be checked in to
RedHat Enterprise Linux (WS)
the StarFlow Extensions project
5.1
on each server configuration. If
there is no StarFlow Extensions
Solaris Sparc 10
project, you need to make one.
Universal Edition for platforms
STE also provides API
that run Java
documentation and samples.
32-bit applications for:
Windows XP Professional
SP3; Windows Vista SP1:
Windows 7

Consolidated
Installation Guide
Yes

Use Workflow Designer to
Yes
create workflows for specific
artifact types (such as change
requests/defects) per project or
even per view.

RedHat Enterprise Linux (WS)
5.1
Solaris Sparc 10
Universal Edition for platforms
that run Java
Notification Agent (2009)

32-bit application for Windows
Server 2003 SP2/2003 R2
SP2 (32-bit or 64-bit) or
Windows Server 2008 (64-bit)

Borland Search (2009)

32-bit application for Windows Use Borland Search to search
XP Professional SP3,
multiple server configurations
Windows Vista SP1, RedHat for data.
Enterprise Linux (WS) 5.1, and
Solaris Sparc 10

*

Datamart (12.0)

*

TeamInspector (12.0)
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Notification Agent runs on the Yes
same computer as the
StarTeam Server (or on a
network near computer) so that
it can monitor the server and
send notifications set up in your
workflow.
No

32-bit applications for
Windows Server 2008 SP1
(64-bit)

Use Datamart to retrieve data No
from multiple server
configurations for use in
creating reports with products
such as Business Objects,
Crystal Reports, or BIRT.
Datamart stores the data in an
Oracle or SQL Server database.
The product comes with both an
Extractor (for an initial retrieval)
and with a Synchronizer to
update an existing set of data.

32-bit applications for
Windows Server 2008 SP1
(64-bit)

TeamInspector is a continuous No
build and build inspection tool.
It works with StarTeam,
Subversion, Perforce and
ClearCase. It requires the use

StarTeam Product

Platform

Description

Consolidated
Installation Guide

of a database: Microsoft SQL
Server 2005 SP3, Oracle
Database 10g Release 2
version 10.2.0.4, or Apache
Derby 10.4.2.0 or later.
*

Can be purchased separately and added to the Enterprise package.

Accessing StarTeam Product Updates
The StarTeam product update patches are available for download from: http://supportline.microfocus.com.

StarTeam Documentation
The StarTeam Help documentation set is your guide to using the StarTeam product suite. StarTeam
documentation is provided in several formats: online help, HTML, and Adobe PDF. Documentation is available
from the Help menu within the product.
If using a Windows system, you can locate documentation for the StarTeam products by accessing the Start
➤ Programs ➤ Borland StarTeam ➤ <Product> ➤ Documentation menu. The Documentation menu lists
all of the available documentation for the selected product.
You can also download documentation directly from the Micro Focus SupportLine Web site:
http://supportline.microfocus.com/productdoc.aspx.

HTML Documentation
The Release Notes documentation is provided in HTML formats for StarTeam.
Readme files can be found directly under the root installation directory (or on the root of the installation CD).
For documentation available in other languages (Japanese, French, or German), the language-specific versions
of the release notes are indicated with an appropriate _countrycode in the filename. For example,
readme_ja.html contains release note information for the Japanese language. PDF manuals are located
in the Documentation subfolder on the product CDs.

Adobe PDF Manuals
The following documentation is provided in Adobe PDF format for StarTeam. All manuals distributed in Adobe
Acrobat (.PDF) format require Adobe Acrobat Reader to display them. The installation program for Adobe
Acrobat Reader is available from the Adobe web site at: www.adobe.com.
•
•
•
•

Installing StarTeam: The StarTeam Installation Guide (this manual) contains detailed instructions for
installing and configuring the “core” StarTeam products.
StarTeam Server Help: This manual is identical to the online help version.
StarTeam Cross-Platform Client Help: This manual is identical to the online help version.
StarTeam Command-line Tools Help: Explains how to use the command-line tools and provides a reference
for the various commands.
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•
•
•

StarTeam File Compare/Merge Help: This manual is identical to the online help version of the File
Compare/Merge help.
StarTeam Extensions User’s Guide: Explains how to design and manage StarTeam Extensions such as
alternate property editors (APEs). It also covers the Workflow Designer and Notification Agent.
StarTeamMPX Administrator’s Guide: Explains the basic operation and architecture of a StarTeamMPX
system, and presents instructions on installing and configuring the StarTeamMPX components.
Note: Depending upon which StarTeam products you purchased and installed, not all of the application
manuals will be on your system.

Micro Focus Support
Borland (a Micro Focus company) is committed to providing world-class services in the areas of consulting
and technical support. Qualified technical support engineers are prepared to handle your support needs on a
case-by-case basis or in an ongoing partnership. Micro Focus provides worldwide support, delivering timely,
reliable service to ensure every customer's business success.
For more information about Micro Focus support services, visit the SupportLine Web site at
http://supportline.microfocus.com where registered users can find product upgrades as well as previous versions
of a product. Additionally, users can find the Knowledge Base, Product Documentation, Community Forums,
and support resources.
When contacting support, be prepared to provide complete information about your environment, the product
version, and a detailed description of the problem, including steps to reproduce the problem.
For support on third-party tools or documentation, contact the vendor of the tool.

Documentation Conventions
The following table lists the documentation conventions that this guide uses.
Convention

Object Indicated, Identified, or Represented

Choose File ➤ Exit to...

A menu selection that precedes a submenu selection. The
arrow separates the commands to be selected from
subsequent menus. For example, the phrase Choose File
➤ Exit means to choose File from the menu bar and then
to choose Exit from the resulting drop-down menu.

Fixed-space font

Code, file names, parameters, information that you need to
type, and messages from the system.

Italics

Information that you replace with the names of your files,
child folders, and so forth. Italics also emphasize words and
identify the names of books.

Bold

UI controls and information that one must use exactly as
shown.

[]

Optional syntax.

|

Mutually exclusive choices.
Note:
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Supplemental information.

Convention
Tip:

Important:

Caution:

Object Indicated, Identified, or Represented
Information about alternative procedures or other helpful but
nonessential information.
Information that is essential to the completion of a task.

Actions that might result in a loss of data, or procedures that
one must follow to avoid losing data.
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Installation Roadmap
Depending on your role, experience with StarTeam, and what products you are installing, use the appropriate
section below as a guide for the installation process you need to follow.

Roadmap for Upgrading
If you are an existing StarTeam user, please note that some products have special upgrade considerations
and instructions:
•
•

Server
StarTeamMPX, specifically StarTeamMPX Cache Agent

For these products, go to the various chapters in this manual for each product to review upgrading instructions:
Upgraded Product

See...

Server

Installing the Server on Windows on page 18

StarTeamMPX Cache Agent

Installing a Cache Agent on page 47

Roadmap for Cross-Platform Client
For information about installing the Cross-Platform Client, see Installing the Cross-Platform Client on page 54.

Roadmap for Server Administrators
If you are the administrator for StarTeam or perhaps the IT Administrator, you install these StarTeam products
on the systems indicated below:
Install this product

On this system...

Server

The computer to be used as the Server; Installing the Server on Windows on page 18
this computer must be accessible to all
StarTeam clients.

StarTeamMPX Message
Broker

One Message Broker serves as the
Installing the Message Broker on page 46
root Message Broker on the same
computer as Server or on a computer
network near to it. Some users use dual
root Message Brokers. Also, remote
Massage Brokers are installed on
computers in various locations.

StarTeamMPX Cache Agent One Cache Agent serves as the root
Cache Agent on the same computer
as the StarTeam Server or on a
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See...

Installing a Cache Agent on page 47

Install this product

On this system...

See...

computer network near to it. Also,
remote Cache Agent Brokers are
installed on computers in various
locations, usually in each major
geographic location and on the same
computer as the remote Message
Broker.
Notification Agent

Usually on the same computer as the Installing Notification Agent on page 81
Server.

Workflow Designer and
StarTeam Extensions

StarTeam administrator's workstation. Installing Workflow Extensions on page 77

Layout Designer

StarTeam administrator's workstation. Installing Layout Designer on page 75

LDAP QuickStart Manager

StarTeam administrator's workstation. ST_LDAPInstall.pdf - available on the Micro Focus
Technical Publications Web site at:
http://www.support.microfocus.com/productdoc.aspx

You can download the latest patches to these StarTeam products from the Micro Focus Web site at:
http://supportline.microfocus.com

Installation Roadmap
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Installing the Server on Windows
This chapter explains how to install the Borland StarTeam Server. It also covers the preparations that should
be made before the installation and the steps you need to take after the installation, particularly if you are
upgrading from an earlier release of the Server.
•
•

If you are evaluating the product for adoption or installing the product for first use on site, you should read
Pre-installation Requirements for a New Installation on page 21
If you are upgrading from an earlier version of the product to a new release, you need to read all of this
chapter. After the installation, you must upgrade each server configuration. See Upgrading to StarTeam
12.5 on page 22

About the Server
The Borland StarTeam Server is a powerful tool that supports distributed development teams and mobile team
members. It supports data in all languages that can be encoded in UTF-8. You can access the data managed
by the Server using a variety of clients. The primary client is the Cross-Platform Client which can be installed
on a variety of platforms.
Other clients use other means to access the server. For example, Web Client can access the server through
supported browsers.
Access to the Server can be local or remote—by way of the Internet, intranet, WAN, or a dial-up connection.
Built-in encryption enables you to work securely over public networks such as the Internet. Normally, you install
the Server on a computer accessible to all team members.You then install StarTeam clients on team members’
workstations. To learn to use the Server, refer to the extensive online help.

System Requirements for the Server
Micro Focus recommends installing the Server on a dedicated application server, and installing the database
on a separate server unless you are using a supported version of Microsoft SQL Server Express as your
database.
Note: There should be a dedicated connection between the computers running the Server and the
database management system. For optimal performance, both machines should be on the same physical
switch.
The following sections show the minimum and recommended hardware for the computer on which you deploy
the Server application and database. Although specific processor speeds are listed, you should always use
the fastest available CPU to maximum performance.

Supported Operating Systems
The following operating systems are supported for this release of the Borland StarTeam Server:
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•
•
•

Microsoft Windows Server 2003 R2 SP2 (32-bit)
Microsoft Windows Server 2008 (32- and 64-bit)
Microsoft Windows Server 2008 R2 (64-bit)
Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer
will return an error upon attempting to install the Java VM.

Supported Databases
The following databases have been tested and are supported for the Server:
Server supports both 32-bit and 64-bit databases.
Supported databases are:
•
•
•
•
•
•
•
•
•

Microsoft SQL Server 2005 Express SP3
Microsoft SQL Server 2008 Express
Microsoft SQL Server 2008 Express R2
Microsoft SQL Server 2005 SP3
Microsoft SQL Server 2008
Microsoft SQL Server 2008 R2
Oracle 10gR2 (10.2.0.4)
Oracle 11g (11.1.0.6)
Oracle 11gR2

By default, the installer uses the following passwords:
•
•

sa: StarTeam123
StarDraw: StarDraw123

Database products must be purchased from the appropriate vendor. For more information, see Database
Server System Requirements on page 20.

StarTeam Server and SQL Express on the Same Computer
When SQL Server Express is used, the database typically resides on the same computer as the corresponding
StarTeam Server application. The following hardware recommendations for a joint StarTeam Server/SQL
Server Express computer are based on the number of seats (registered users)—although your situation might
vary depending on the size of your StarTeam projects and the number of projects managed by the server
configuration.
The following table lists suggested system configuration requirements if you are using SQL Server Express
and the Server on the same computer.
Number of Seats

Recommended Configuration

less than 50

32-bit dual core machine with 4GB of RAM

50 – 100

32-bit quad core machine with 4-8GB of RAM

Note: SQL Server Express is not recommended for configurations serving more than 100 registered
users.

Installing the Server on Windows
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StarTeam Server and Database on Different Computers
The following hardware recommendations apply when the StarTeam Server application is executing on a
different computer than the database server.They are based on the number of peak users (maximum concurrent
users during peak periods)—although your situation might vary depending on the size of your StarTeam projects
and the number of projects managed by the server configuration.
Number of Peak Users

Recommended Configuration

less than 100

32-bit, dual-core systems with 4GB of memory

100 - 200

32-bit, quad-core systems with 4-8GB of memory

more than 200

64-bit, quad-core systems with 8-16GB of memory

Database Server System Requirements
The following recommendations apply to the database server when it is not on the same computer as the
Server. The number of peak users is the maximum number of concurrent users during peak usage periods.
Number of Peak
Users
less than 100

Hardware Configuration

Database Requirements

Computer with a dual core processor and 4GB Minimum: Microsoft SQL Server Express 2005
of RAM
SP2
Recommended:
•
•

Oracle 10g R2 (10.2.0.4) and 11g (11.1.0.6),
and 11gR2
Microsoft SQL Server 2005 SP2, 2008, and
2008R2

100 - 200

Minimum: Computer with quad processors and Minimum and recommended:
4 GB of RAM
• Oracle 10g R2 (10.2.0.4) and 11g (11.1.0.6),
Recommended: Minimum configuration plus
and 11gR2
RAID system
• Microsoft SQL Server 2005 SP2, 2008, and
2008R2

more than 200

Minimum: Any high-performance Enterprise
Server with quad processors and 4-8 GB of
RAM

Minimum and recommended:

Recommended: Minimum configuration plus
RAID system

•

•

Oracle 10g R2 (10.2.0.4) and 11g (11.1.0.6),
and 11gR2
Microsoft SQL Server 2005 SP2, 2008, and
2008R2

Third-Party Software Requirements
Server uses Sun Microsystems Java Virtual Machine 1.6.0_29 which is automatically installed at C:\Program
Files\Borland\Java\Sun1.6.0_29.
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Adobe Acrobat Reader is needed to read the StarTeam manuals which delivered in Adobe’s Portable Document
Format (.pdf), and can be viewed with the latest version of Adobe’s free Acrobat Reader. You can download
the latest version of the Acrobat Reader from Adobe’s web site at http://www.adobe.com.

Large Memory Support
On 32-bit Windows systems, you can use 4GT RAM tuning to enable the Server application to utilize 3 GBs
of memory. To enable this feature, you must add the /3GB switch to the Boot.ini file. For information about
setting this switch, see:
http://msdn2.microsoft.com/en-us/library/aa366521.aspx
On 32-bit Windows, you should also be aware of the maximum page file size, which can affect memory allocation
when multiple applications are run on the same computer. See the article:
http://support.microsoft.com/kb/237740
You should also be aware of Page Table Entry (PTE) limitations when the /3GB switch is used. See:
http://support.microsoft.com/default.aspx?scid=kb;EN-US;311901

Understanding Server Support of Unicode Character Sets
While Server supports data in all languages that can be encoded in UTF-8, it uses only ASCII characters
(0-127) as it expands keywords. Keyword expansion and EOL conversion should work for all “ASCII-based”
encodings, which include UTF-8, Cp1252, and so on. For the various UTF-16 encodings, StarTeam currently
performs EOL conversion, but does not expand keywords.
The internal names of custom fields must be ASCII, but the display names can be in non-English character
sets.

Pre-installation Requirements for a New Installation
Before you install StarTeam Server:
1. Make sure your computer system meets the minimum requirements. For more information, see System
Requirements for the Server on page 18.
2. You must be a local administrator on the target computer to install Server and other StarTeam products.
Also, the local settings for the administrator account performing the install must be stored on the target
computer. Server and StarTeam clients will not operate correctly if the local settings are stored on a network
drive.
3. You must set video settings on the computer on which you install Server to 256 colors or higher.
4. Unless you plan to use only SQL Server Express, which is the default database for server configurations,
you must install the database management system you plan to use with Server. It is usual to install the
database server on another computer. Make sure your computer system meets the minimum requirements
for the database product. Refer to the documentation supplied with your database management system
for more information. See Database Server System Requirements on page 20 for more information about
supported databases.
Note: There should be a dedicated connection between the computers running Server and the database
management system. For optimal performance, both computers should be on the same physical switch.
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5. Install the database client on the same computer as Server.
6. Because Server can be used with any UTF-8 character set, the code page settings for the databases can
be very important. Information about this can be found in the chapter on creating a server configuration for
your database type.
•
•

For Microsoft SQL Server and SQL Server Express databases, see Understanding the Encoding
Differences on page 82.
For Oracle databases, see Database Character Set and StarTeam Server on page 99.

Upgrading to StarTeam 12.5
If you have used previous releases of Borland StarTeam Server , you must upgrade each of your server
configurations after installing the new release. The upgrade process varies depending upon:
•
•

Which database you are using.
Which previous release of Borland StarTeam Server you are using.

To determine if a patch is required before you upgrade, contact Micro Focus Technical Support at:
http://support.microfocus.com.

Preparing for an Upgrade
Before upgrading, you should do the following:
•

Perform test upgrades.
Micro Focus strongly recommends running test upgrades against copies of current production databases.

•

Create an upgrade schedule.
Plan your server upgrade when it will inconvenience the smallest number of users. A server configuration
cannot be running during some of the steps you take before and during the upgrade. You may want to plan
the server upgrade at the end of the workday or perhaps on a weekend. If you have a large repository or
a slow system, the upgrade process could be time consuming. Depending on the size of your database,
you might need to schedule a couple of downtimes for the upgrade. For example, you might schedule one
weekend for upgrading the server and another for upgrading the database. Make backups before and after
each of these steps to prevent loss of data.
Advise your team ahead of time that you plan to make this transition during a specified period of time, and
advise them when they will need to have the latest version of a StarTeam client installed. Unless specifically
stated, StarTeam clients for a given release work with that Server release, one release back, and one
release forward. When an older client works with a newer server, the client cannot access new features.
For example, the older client cannot display any new menu commands.

•

Backup the server configuration.
Make certain you have current, verified backups of the files and folders for the server configuration (database
files, archive files, and so on) prior to starting important steps in the upgrade process.

Overview of the Upgrade Process
The following table provides an overview of the upgrade process. See the following sections for more information.
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Old Release

New Release

Upgrade Procedure

12.0

12.5

1. Back up your StarTeam repositories and other server
files.
2. Install Server <latest version>.
3. If necessary, upgrade or migrate your database to a
version supported by Server <latest version>.

2009 Release 2
2009
2008 Release 2

Requirements for an Upgrade
This section describes the steps that you follow to upgrade to the latest version of StarTeam Server, elaborating
on the table provided in Overview of the Upgrade Process on page 22 and providing references to related
sections for more detailed information.
Before upgrading to the latest version of StarTeam , you need to:
1. Review the pre-installation issues for a new installation to determine whether any of them apply to you.
See Pre-installation Requirements for a New Installation on page 21.
2. You can upgrade to Server 12.5 only from Server 2008 Release 2, 2009, 2009 R2, or 12.0. If you are on
an earlier release, take the steps necessary to upgrade from that release to Server 2008 Release 2 or
2009. See the appropriate installation guides for details. Be sure to also install the latest patches. You can
find information about the latest patches at http://supportline.microfocus.com.
3. Back up your StarTeam repositories and other server files. See the documentation for the release of Server
that you currently have installed for information about what to back up.
4. You cannot install Server while server configurations are running. Therefore, you must perform one of the
following procedures.
•

To shut down a server configuration that is not running as a Windows service:
1. Start the Server Administration tool, by selecting Start ➤ Programs ➤ Borland StarTeam ➤
StarTeam Server <version> ➤ StarTeam Server. The Server Administration tool opens.
2. Select the server configuration, and choose Actions ➤ Shut Down Server. After you confirm that
you want to shut down the server, the Status icon changes from “Running” to “Stopping” to “Ready”.

•

If your Server configurations run as Windows services, you must stop those services and change the
StarTeam execution mode:
1. Display the Windows Control Panel by selecting Start ➤ Settings ➤ Control Panel ➤ Administrative
Tools ➤ Services. The Services window opens.
2. Locate the Server configuration and click Stop.
3. After the service stops, close the Services dialog box and the Control Panel.
4. Stop the server configuration from being run as a service. For example, in Server 2009, start the
Server Administration tool by selecting Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam
Server <version> ➤ StarTeam Server. The Server Administration tool opens.
5. Select the server configuration, and choose Actions ➤ Set to Run as Service. This menu command
changes from checked to unchecked, indicating that the server configuration is no longer running as
a service. The server configuration’s icon also changes.

5. Install Server <latest version> on the same computer as the version of Server that you are upgrading from.
For more information, see Installing theBorland StarTeam Server on page 27.
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6. If necessary, upgrade or migrate your database to a version supported by Server latest version. For more
information, see Database Requirements for Upgrading on page 24.
Note: Performing the server installation and the database upgrade in different sessions, such as
different weekends, allows you to isolate any problems to one step or the other. If your database version
is not one that is supported by the latest version of Server, perform the database migration prior to
installing the latest version ofServer. If performing an upgrade of both the server and the database,
upgrade the database, install Server, then upgrade or migrate your database to another database
version.
7. Upgrade your server configurations. For more information, see Upgrading Server Configurations on page
26.

Database Requirements for Upgrading
If necessary, you must upgrade or migrate your database to a version supported by the new version of the
Server.
For more information about which databases are supported by Server, see System Requirements for the
Server on page 18.

Orphaned Users
When a database user for a corresponding SQL Server Login is undefined or incorrectly defined, SQL Server
does not allow the user to log on to that instance. Such a user is said to be an orphaned user of the database
instance. A database user can become orphaned if the corresponding SQL Server user name is dropped.
Most likely, a database user becomes orphaned after a database is restored or attached to a different instance
of SQL Server. Orphans occur if the database user is mapped to a security ID that is not present in the new
server instance.
Use SQL Server Management Studio or any other tool that executes SQL statements to address all orphaned
users before you start or upgrade the StarTeam Server configuration.

Addressing Orphaned Users
Use SQL Server Management Studio or any other tool that executes SQL statements to address all orphaned
users before starting or upgrading the StarTeam Server configuration. Use either the system administrator
user name (sa) or windows authentication (under an administrative user account) to connect to the database
and change the database context for the SQL console to the StarTeam database.
To address all orphaned users:
1. Open a SQL console such as SQL Server Management Studio or Enterprise Manager.
2. Open a new query.
3. Enter the following command to display the user names of all orphaned users:
sp_change_users_login 'REPORT'
4. Enter the following to address the orphaned database owner (dbo). The database user is always orphaned
when changing servers.
sp_addlogin User Name , Password
go
sp_changedbowner User Name
go
sp_defaultdb User Name , Database Name
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User Name is the appropriate user name, Password is the appropriate password for the StarTeam Server,
and Database Name is the StarTeam Database.
5. For all other users who are returned as orphans, repeat the following commands for each of the orphaned
users:
sp_addlogin User Name, Password
go
EXEC sp_change_users_login 'Update_One',
'Orphaned User Name', 'New User Name'
where the Orphaned User Name is the orphaned user from the previous server and the New User Name
is the new login created in the previous step.
6. Enter the following command: sp_change_users_login 'REPORT'. This command should not return
any rows.
For more information, refer to the Troubleshooting Orphaned Users section in the SQL Server documentation.

Granting Oracle Privileges
If your server configuration uses an Oracle schema user that was not created automatically by Server, you
should check it for all the privileges listed below. These privileges ensure that Server can create labels and
perform other operations successfully and should be explicitly defined rather than relegated to a role.
•
•
•
•
•
•
•
•
•
•

Create procedure
Create sequence
Create session
Create table
Create trigger
Create type
Create view
Unlimited tablespace
Create any context
Drop any context

The following procedure explains how to explicitly define Oracle privileges, using the “create type” privilege
as an example.
To explicitly define the “create type” privilege:
1. Log on to the database as system user.
2. Execute the following SQL statement:
grant create type to schema_user
where schema_user is the name of the Oracle schema user.

Setting Database Compatibility Level for Microsoft SQL Server 2008
Change the database compatibility level to 100 for all existing databases that will be upgraded from an earlier
version of SQL Server. All new configurations created against SQL Server 2008 databases will have the correct
value.
To set the database compatibility level:
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1. Log on to the database instance.
2. Execute the command:
sp_dbcmptlevel @dbname = name,@new_cmptlevel = version]
Arguments: @dbname=name is the database name for which you are changing the compatibility level.
Database names must conform to the identifier rules. @new_cmptlevel=version is the SQL Server
version with which to make the database compatible. The value must be set to 100.

Upgrading Server Configurations
After you install Server, every existing server configuration must be upgraded except for StarDraw. A new
ready-for-the-current-release StarDraw should have been installed with the server.
1. From the Windows Start menu, select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Select the server configuration to be upgraded.
Even if the status for the server configuration indicates “Ready”, the server configuration will not start
successfully until you run the upgrade procedure.
3. Click the Upgrade Database toolbar button.
A series of dialog boxes may open and close. At the completion of the process, a message indicates a
successful upgrade operation. If an error occurs, a message displays the error information. The upgrade
process creates a log file named DBUpgrade.locale.log in the server configuration's repository folder.
For example, if the locale is the United States, the name of the file is DBUpgrade.en-US.log.
Note: The upgrade process requires one database connection to run. If the upgrade process is unable
to acquire a connection, it will fail.
•

Check the database connection information on the Server computer. From the computer on which
the server is installed:
1.
2.
3.
4.
5.

•

Open the Server Administration tool.
Select the server configuration.
Choose Server ➤ Configuration Properties.
From the Properties dialog box, select the Database Connections tab.
Click Verify.

Ensure that the database is running.

Changes to Server Files
The old starteam-server-configs.xml file is copied from the old Server release’s installation folder to
the new release’s installation folder. This ensures that all configurations running on the previous server release
can access the new server release.
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Installing theBorland StarTeam Server
Before you install the Server, make sure you read Pre-installation Requirements for a New Installation on page
21. If you are upgrading from a previous release of the Server, make sure that you also read Upgrading to
StarTeam 12.5 on page 22.
1.
2.
3.
4.
5.

Close all other Windows applications.
Run the downloaded installer.
Select a language from the drop-down list box, and then click OK.
In the Introduction dialog box, read the information, and click Next.
In the License Agreement dialog box, read the agreement.
If you agree with the license agreement, click I accept.... If you do not accept the license agreement, you
cannot install the product.
6. Click Next.
7. In the Choose Install Set dialog box, choose either Typical, Compact, or Custom.
•

•

•

Typical installs Server with the most common options. Recommended for most users. Those options
are Program Files, Sample Server Configuration, SQL Server Express, and the sever's Online
Documentation.
Compact installs Server with the minimum required options. Only the Program Files and Online Help
are installed. Use this if you will not be using SQL Server Express as the database and do not want to
install the StarDraw Sample server configuration.
Custom enables you to choose the options you want to install. Recommended for advanced users.

Be sure to perform a custom installation if you want to
•
•

Enable users to install the StarTeam Client over the network from the computer on which Server is
installed.
Avoid installing the StarDraw sample repository/SQL Server Express.

8. For a Custom Install only, select (to install) or clear (to bypass) the available options:
•

•

•

•

•

Server - If you use the custom installation to install something that was not installed during a previous
installation of Server, you may choose to uncheck this check box. For example, suppose that in a
previous custom installation, you elected to bypass the installation of SQL Server Express. To add that
database now without reinstalling all of the server program files, you would clear the Server check box.
Client Setup - The client setup files are not automatically part of the server installation. If you select the
Client Setup check box, the Cross-Platform Client installer is installed in the Client Setup folder, a child
folder of the Server installation folder. Make sure that this folder is one that all team members can access.
SSE 2005 - SQL Server Express is a variant of Microsoft SQL Server offered by Microsoft at no extra
charge, as long as you comply with their stipulations. SSE2005_ST is installed as part of the typical
installation because it is used as the default database. If you use an enterprise-level database exclusively
(Microsoft SQL Server or Oracle), you might not be interested in having the SQL Server Express files
added to the server's computer.
Sample server configuration - Clear this check box if you do not want to install StarDraw. Installing
the StarDraw sample server configuration for this release will not overwrite an existing StarDraw
configuration. However, the StarDraw server configuration in the StarTeam
starteam-server-configs.xml file will refer to the new StarDraw server configuration.
StarTeam Toolbar - Installs the StarTeam Toolbar which remembers passwords so that logging on is
easier.
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9. Click Next.
10. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the installation
folder. The default location is C:\Program Files\Borland\Server <version>.
11. Use the MPX Options dialog box to make changes to the MPX profiles used by your server configurations.
If this is the first time that the StarTeamMPX Event and File Transmitters have been installed on this
computer, the installer creates both Event Transmitter and File Transmitter template files using information
from the MPX Options dialog box. These files are stored in a subfolder of the installation folder named
EventServices.
The local host name and IP address are provided at the top of this dialog box for reference purposes.
By default, the Message Broker connection address uses your local computer's IP address.
12. To specify a different Message Broker for Event Transmitter (and any clients that will use the default profile),
change the proposed Message Broker connection address.
This address must use the format:
tcp:host:port
host is the host name or IP address on which the Message Broker operates.
port is the TCP/IP port number (endpoint) with which the Message Broker accepts connections (5101 is
the default).
Important: When installing to a computer that has more than one NIC or multiple IP addresses, do
not accept the default server address settings. You must manually enter the correct server IP address.
When the installer detects multiple network addresses on the host computer, it sets up default profiles
that contain a server-address property whose syntax is invalid because it contains multiple addresses.
Tip: You can enter the connection information for more than one Message Broker. In the event that
the Event Transmitter (or a client using the default profile) is unable to connect with the first Message
Broker in the list, it will attempt to connect with the next Message Broker listed. Separate the address
for each Message Broker with a comma (,). For example: tcp:HostA:5101,tcp:HostB:4999
13. Click Next.
See Chapter 4, "Managing the Transmitters" in the StarTeamMPX Administrator's Guide for more information
on creating and editing connection profiles.
14. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\Programs\Borland StarTeam\StarTeam Server
<version>).
15. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box, and
click Next.
16. If you already had SQL Server Express installed on your computer, enter the password, and click Install.
17. In the Install Complete dialog box, click Done.
18. After you finish installing Server, ensure that the permissions on the Server installation folder and files are
set correctly. The Windows account for the StarTeam administrator must have full permissions on the
installation folder and files. Set the Windows permissions for all other StarTeam users in accordance with
your company policy. See your network administrator if you need assistance.
If you use the default location, installing Server places files in the following folders under your Program
Files folder:
•
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This folder and its subfolders contains the executables, DLLs, and utilities used to run Server. This folder
also contains the StarTeam_Server_<version>_InstallLog.log file, which documents what happened
during the installation process.
•

Borland\Server <version>\EventServices
This folder contains the Event Transmitter and File Transmitter template files. It has a subfolder for each
existing server configuration. Inside those subfolders are the MPXEventTransmitter.xml and
FileTransmitter.xml files that will be used by the server configurations. If you have an Enterprise server,
you may want to delete the FileTransmitterTemplate.xml and FileTransmitter.xml files. The file transmitter
is part of Enterprise Advantage only.

•

Borland\StarTeam SDK <version>
This folder contains the StarTeam SDK Runtime required for clients to access Server.

Known Installation Issue
The SQL Server Express installation can fail due to insufficient registry privileges. The error is similar to the
following:
InstallSQLAgentSecurity failed (computer_name,LocalSystem,203)
The resolution is to change the security of the HKEY_LOCAL_MACHINE\Software\ Microsoft\Microsoft SQL
Server key to “Full Control”, and then reinstall SQL Server Express. This can be changed using the Windows
registry editor (regedt32).

Post-installation Tasks for a New Installation
If you have not installed Server previously, you must perform the following tasks before team members can
begin using StarTeam.
1. Create a server configuration using the Server Administration tool.
For details about creating a server configuration, see the chapter about your database type:
•
•

Using StarTeam with Microsoft SQL Server and SQL Server Express Databases on page 82
Using StarTeam with Oracle Databases on page 95

When you create a server configuration, you set values for the configuration’s session options, which are
stored in the starteam-server-configs.xml file. Session options specify the core information that Server
requires to start a server configuration.
2. Log on to that configuration using the Server Administration tool.
Server comes with a free administrative user, named "StarTeam Server Administrator". That user has the
default logon name "Administrator" and the default password “Administrator”.
3. Configure the server using the Server Administration tool and, for some options, by editing the file
starteam-server-configs.xml.
After the server configuration is created, you can set configuration options, which are stored in the database
for the server configuration. Configuration options enable you to fine-tune server configuration performance
and enable the use of several features, such as:
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•
•

Email and audit features
Compression and encrypting of data that is transferred between the server and client workstations

4. Add users and groups using the Server Administration tool.
5. Create projects and views using the StarTeam Cross-Platform Client.
6. Set the appropriate access rights for the server configuration, projects, and views using the Server
Administration tool and the StarTeam Cross-Platform Client.
7. If desired, you can run the server configuration as a Microsoft Windows service using the Server
Administration tool.
See the StarTeam Server online help for more information about steps 3 through 7.

Post-installation Tasks for an Upgrade
If you are upgrading from a previous release of StarTeam Server, be aware of the following:
•

•
•

You must upgrade all existing StarTeam server configurations to use the latest release of StarTeam Server.
For more information about upgrading server configurations, see Upgrading Server Configurations on page
26.
If you use StarTeamMPX, be sure to install the latest Message Broker and Cache Agents. For more
information, see Installing StarTeamMPX on Windows on page 43.
For more information about installation and upgrade instructions for StarTeam Workflow Extensions, see
Installing Workflow Extensions on page 77.

Evaluating the Server
The first time you run Server, an evaluation license is created for StarTeam Enterprise Advantage, which is
the edition of StarTeam with the largest feature set. Before the 30-day product review period expires, you can
extend the evaluation period by contacting Micro Focus Sales for an extended evaluation key.
Be sure to register the product or extend the evaluation period before it expires. Otherwise, when clients access
a server configuration managed by StarTeam Server, no components (such as the file or change request
component) are available. For example, in the Cross-Platform Client, the upper and lower panes have no tabs.
To extend the evaluation period for the Server:
1. After you obtain an extended evaluation key, select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam
Server <version> ➤ StarTeam Server The Server Administration tool opens.
2. Select Help ➤ About from the menu bar. The About StarTeam Server dialog box opens.
3.
4.
5.
6.
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Select License in the left pane of the dialog box.
Click Extend Evaluation. The Extend Evaluation dialog box opens.
Enter the evaluation key, and click OK.
Close the About StarTeam Server dialog box.
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Licensing the Server
Server can be run as an Express, Enterprise, or Enterprise Advantage server. Which server edition you have
(or more explicitly, what features a client can access on that server) is determined by the product license.

Understanding Licensing
Licenses determine how many users can access Server. Users can have either named user or concurrent
licenses. A named user license can be used only by the user who has been assigned that license. For example,
if you have 5 named user licenses, the 5 users who are assigned the named user licenses are guaranteed
access to the server. No one else can use their licenses.
A concurrent license can be used by any user who does not have a named user license. For example, users
without named user licenses receive concurrent licenses on a first-come, first-served basis. After all the
concurrent licenses are in use, users attempting to log on are notified that there are no more licenses available
at this time. They can try again later.
You can add as many users as you choose, but access to the server is granted only to users with named user
licenses or to users who receive concurrent licenses as they log on.
Tip: You can import user information from Active Directory or OpenLDAP and assign users to StarTeam
license types or license server slips using LDAP QuickStart Manager. Refer to the LDAP QuickStart
Manager Administrator Guide for more information.
The Server Administrator is automatically assigned a named user license which cannot be removed. This is
a “free” license that is not counted against the number of named user licenses you have available.
Important: The Server Administrator should not have a password that is verified by a directory service
because, if you change the service, the adminstrator will be locked out.
Server can be licensed in either of two ways:
•
•

StarTeam licensing, also referred to as native licensing, which is internal to the product
License Server licensing (using either BLS or FLEXnet Server)

If you have StarTeam native named user licenses, you must assign them to specific users in the User Manager
dialog box. Everyone else is assumed to have a StarTeam concurrent license. See the StarTeam Server online
help for details.
If you have Borland License Sever (BLS) or FLEXnet License Server, users must be assigned to the correct
slip in the User Manager dialog box, regardless of their named or concurrent user status. An additional status,
Unassigned, may be used instead of a slip.

Using StarTeam Licensing
If StarTeam users attempt to access a server configuration that is managed by an unlicensed version of Server,
the tabs in the upper and lower panes of their StarTeam clients will not display.
Customers buy named Enterprise, concurrent Enterprise, named Enterprise Advantage, or concurrent Enterprise
Advantage licenses for Server. Any client can access any server as long as that server recognizes the user
and has a license for that user. Customers usually choose just one method of licensing, but combinations can
be supported as long as they are all for the same StarTeam edition. Licensing is handled after the installation,

Installing the Server on Windows

| 31

either by setting up a licensing server and putting "slip" files in the Server's \Licenses folder (a child of the
server's installation folder) or by registering StarTeam native licenses using the Server Administration tool.
Before entering StarTeam native licenses, you must delete the evaluation key. For StarTeam Enterprise and
Enterprise Advantage, licenses are stackable as long as they are for the same edition of StarTeam. For
example, when you first register your server, you might enter two serial numbers: one for named user licenses
and another for concurrent licenses. For more information about licensing, see Understanding Licensing on
page 31
You can add more named users or concurrent licenses. Server keeps track of the total number by summing
the licenses supplied in each serial number or slip. This is referred to as stackable licensing.
Note:
•
•
•

You cannot license Server while any of its server configurations are running as a Windows service.
If you change the registered license while a StarTeam project is open on a user’s workstation, the
licensing takes effect for that user by closing and reopening the project window.
If you license a Server as Express or Enterprise after using an evaluation license which is for the
Enterprise Advantage edition, the feature set changes. For example, if you created requirements during
the evaluation and then license the server as anything other than Enterprise Advantage, the requirements
tab disappears.

To license Server from the Server Administration tool (native licensing):
1. From the Windows Start menu, select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. On the Server Administration menu bar, Select Help ➤ About. The About StarTeam Server dialog box
opens.
3. Select the License node in the left pane of the dialog box.
4. If you have yet to enter a license, you must delete the evaluation key by selecting it from the right pane of
the dialog box and clicking Delete.
5. Click Register. The Server Registration dialog box opens.
6. Enter the correct numbers in the Serial Number and Access Key text boxes. Serial numbers are case
sensitive; access keys are not.
7. Click OK.
8. Close the About StarTeam Server dialog box.
Tip: To license a version of Server at the command prompt, enter the following: starteamserver
-serial Number -access Key

Using a License Server
You can use Borland License Server (BLS) or FLEXnet License Server with the Server. This gives you a choice
between using a license server and using the StarTeam native licensing found in this and earlier releases.
Important: BLS should be added to the Windows firewall exceptions (on the BLS server machine) when
BLS is started as a Windows service. Otherwise the Server will be unable to connect to the BLS.
Note:
•
•
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If you use a license server, users must use their network logon names as their StarTeam user names.
A single license server can handle licenses for multiple StarTeam releases and for multiple product
releases.
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•
•

FLEXnet License Server configuration files on Linux are case sensitive.
When Server starts up, it checks for slips and stores information about them in memory. It does not
recognize new slips until the next restart.
When a user logs in from a StarTeam client application, Server tells the client application what features
are available to its user based on the license assigned to that user.
If the user is assigned a license from a slip, but that slip is no longer in the license folder, Server displays
an error message. If the license type for that user is Unassigned, the user is not logged on and Server
returns an exception.

•
•

The administrator does the following to configure the license server:
1. Receives licensing information from Micro Focus Distribution through email.
Tip: If you need this information, contact your sales representative.
2. Installs the license server.
For Borland License Server (BLS), download a copy of BLS from http://license.borland.com/lservers/belise.jsp.
For FLEXnet License Server, download a copy of the FLEXnet Lisence Server from
http://license.borland.com/lservers/flexlm.jsp.
Note: Refer to the documentation that is available with the license server.
3. Obtains license slips for the Server using the Micro Focus product license activation process. The
adminstrator:
a) Goes to http://supportline.microfocus.com/licensing/borlandactivatelic.aspx.
b) Provides the serial number from Micro Focus and an email address where the slips will be sent.
c) Provides information about the computer where the license server is installed:
•
•

For BLS, provides the IP address, host name, and port number for both the installation computer
and a backup computer.
For FLEXnet License Server, provides the MAC address, host name, and port number for the
installation computer.

4. Saves the slip files.
•

•

For BLS, the email contains two slips: one starting with "server_". While BLS is not running, that .slip
file is copied into the /conf or /named folder, a subfolder of the BLS installation folder. The file named
admin_guide.html, located in the /docs subfolder, provides detailed instructions. The other .slip
file, the one starting wtih "concurrent_" or "named_" is copied into the /license folder, a subfolder of
the Server installation folder.
For FLEXnet License Server, the email contains a .dat and a .slip file. The .dat file is copied into the
FLEXnet License Server installation folder. The FLEXlm End Users Guide (enduser.pdf) provides detailed
instructions. The .slip file is copied into the /License folder, a subfolder of the Server installation folder.

5. Configures the license server for users. For more information, refer to the documentation that is available
with the license server.
6. Uses the Server Administration tool to:
•
•

Make sure that StarTeam user names are network logon names.
Assign users to specific "named_" or "concurrent_" slips.
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StarDraw
Micro Focus provides the sample database StarDraw with StarTeam Server. The StarTeam Server installation
procedure:
•
•

Creates the Samples directory and subdirectories under the installation directory and copies the sample
repository files into them.
Copies the Oracle export file stardraw.dat into the install_dir/starteamserver2009
R2/Samples/StarDraw_Repository/Database directory.

Using the StarDraw Sample Server Configuration
StarTeam provides a sample server configuration named StarDraw. It contains a Visual C++ sample application
and related materials. You can use the StarDraw sample repository to experiment with and learn more about
StarTeam.
During the Server installation procedure, the sample server configuration is installed as part of the Typical
installation and can be installed as part of the Custom installation.The installer creates the Sample by performing
the following actions:
•
•
•

Copies the stardraw.mdf database into the StarTeam Server
<version>\Samples\StarDraw_SSE2005\Database folder.
Copies sample files into the StarTeam Server
<version>\Samples\StarDraw_SSE2005\StarDraw\Archives folder and its subfolders.
Adds the new StarDraw server configuration to the starteam-server-configs.xml file. If a previous StarDraw
server configuration is defined in that file, its settings are updated for the new release’s version of StarDraw.
Important:
In the starteam-server-configs.xml file, the predefined value of ServerGuid for the StarDraw Repository
is:
be5ee3b0-c719-49c6-a1a1-f493764a03f5
Do not change this value. The StarDraw server configuration will not start if you modify the ServerGuid.

Use the StarDraw server configuration only for experimentation and training—never for live data.

Using the StarDraw Server Configuration
To use the StarDraw server configuration:
1. Give all StarTeam Server users read-write access privileges to the Samples directory and its subdirectories.
2. Start the Server Administration application.
3. Select the StarDraw configuration and choose Server > Configuration Properties….
The StarDraw Properties dialog box appears.
4. In the TNS service name text box on the Database Connection Information tab, type the Oracle database
instance name that hosts the StarDraw sample database.
5. Click Verify Connection... to verify the database connection.
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6. Click OK.
7. In the Servers tree view in the left pane, select the StarDraw configuration and choose Actions>Start.
If using a different port than the default, choose Actions > Start with Override....
The StarDraw server configuration starts.
Note: It may take the StarTeam Server several minutes to perform the startup tasks the first time a
server configuration starts.

Restoring the StarDraw Database Backup File
To restore the StarDraw database backup file on the Oracle database machine:
1. If you have not already done so, create the following on the Oracle database machine:
•
•

A database instance that will host the StarDraw database. StarDraw can share the database instance
with other databases.
A tablespace named stardraw on this instance. Following is a sample create tablespace command:
Create tablespace stardraw datafile 'c:\stardraw.dbf' size 400m autoextend
on next 10k maxsize 32767m extent management local

2. If StarTeam Server for Linux is on a different machine than your Oracle database, copy the file
stardraw.dat to the database machine. Using SQLplus, create an Oracle virtual directory that points to
the location of stardraw.dat. For example:
•
Windows

•

SQL> create or replace directory test_dir as
'C:\stardraw_dir';
SQL> grant read,write on directory test_dir to public;

where stardraw_dir is the folder that contains the file stardraw.dat.
•
Unix
•

SQL> create or replace directory test_dir as
'install_dir/starteamserver2009/Samples/StarDraw_Repository/
Database';
SQL> grant read,write on directory test_dir to public;

3. Run the following command (logged in as your Oracle user if your Oracle database is on Linux):
impdp system/password directory=test_dir dumpfile=stardraw.dat
logfile=stardraw.log
where password is the password for the "system" Oracle schema user, and test_dir is the Oracle virtual
directory created in step 2.

Uninstalling Server on Windows
StarTeam Server uses InstallAnywhere for installing and uninstalling. If you encounter one of the following
Java VM errors when uninstalling this product on a Windows operating system, you may need to install JRE
1.6.0_29 or earlier from the Sun website.
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Uninstall errors:
•
•
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Can't launch executable. Could not find a suitable Java Virtual machine on your system.
Windows error 3 occurred while loading the Java VM.
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Installing the Server on Linux
This chapter explains how to install the Borland StarTeam Server on Linux.

Migration Strategies
This section outlines the migration strategies to move StarTeam Server from Windows to Linux. Due to the
complexity of the product, Micro Focus recommends that you run the migration in a test environment and that
you develop a backup strategy to deal with any unexpected errors.
The outline provides an experienced StarTeam administrator with the information needed to plan and run a
StarTeam server migration from Windows to Linux.
To perform a migration, both servers, the source Windows server and the destination Linux server must not
be in production use. From a hardware perspective, the Linux server must be configured to support the
production environment. Both servers must be connected and configured so that files can be copied from the
Windows server to the Linux server.

Migrating from StarTeam 2008 Server for Windows to
StarTeam 2009 Server for Linux
The StarTeam 2008 and 2008 R2 Servers for Windows support both Oracle and Microsoft SQL Server relational
database management systems (RDBMS's), while StarTeam 2009 Server for Linux supports only Oracle. For
more details about supported database platforms, see System Requirements and Prerequisites on page 38.
Important: The following steps assume that the original Windows StarTeam configuration you are migrating
uses an Oracle database. If you are migrating a StarTeam 2008/2008R2 for Windows configuration that
uses SQL Server, you must first migrate it to Oracle using the steps specified in the Migrating Server
Configurations to Other Databases topic of the StarTeam 2008/2008 R2 Server for Windows Help. After
you successfully migrate your StarTeam Server for Windows configuration to an Oracle database, you
can proceed with the following Windows to Linux migration steps.
1. Back up the current Oracle database (schema used for storing StarTeam 2008/2008 R2 Server for Windows
metadata).
Save this backup copy; do not recycle it.
2. Install StarTeam 2009 Server for Linux on the Linux machine.
3. Copy the configuration file and hive index files from Windows to the StarTeam 2009 Server for Linux
installation folder.
4. Copy the vault, including the attachments, from the Windows server to the Linux Server.
5. Install the Oracle client on the Linux machine.
Verify that the supported Oracle client versions for this release are installed.
6. Create a StarTeam user account on the Linux machine.
7. Establish Oracle connectivity between the Linux machine and the Oracle database currently used for storing
StarTeam metadata.
8. Verify the database connectivity using SQL*Plus.
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9. Open the Server Tools, and choose Help > About > License to verify that the Server is licensed correctly.
10. Select the configuration, and choose Server > Configuration from the menu.
11. On the General tab, set the correct log file path.
12. Select the Database Connection Information tab, and click Verify Connection to verify the database
connectivity.
13. Choose Tools > Administration > Hive Manager from Server Administration to update the hives.
If there are multiple hives, ensure that all of them are set correctly.
14. Choose Help > About > Info from Server Administration to verify that the destination build number is greater
than or equal to the source build on Windows. If the destination build number is greater than the source
build number, choose Actions > Upgrade.
This step upgrades the source database to the destination's build. Upgrade is not required when the source
and destination builds are identical.
15. Verify that the upgrade log that gets created in the log file path directory is error free.
16. Back up the current Oracle database.
Save this backup copy; do not recycle it.
17. Verify the upgrade process by starting the server with an Override and browsing to the Attachments path
to reset the Attachments directory.
Verify that the attachments from Windows are copied over to the Attachments directory.
18. Verify that the server log that gets created in the log file path directory is clean.

Assumed Knowledge
Before installing and configuring StarTeam Server and StarTeamMPX Server components for Linux, the
StarTeam administrator must be familiar with the following concepts and procedures:
•
•
•

Creating and modifying relational databases
Working with the features of their operating system, such as creating files, running executables, and
managing access rights
Basic configuration management concepts

For more information about installing StarTeamMPX on Linux, see Installing StarTeamMPX on Linux on page
51.

System Requirements and Prerequisites
•

Red Hat Enterprise Linux 5
Note: Advanced platform storage, virtualization, and high availability features (Red Hat Global File
System & Cluster Suite) are not supported.

•

Oracle Client 10g Release 2 (10.02.00.04) for Linux x86
Note: The Oracle database does not have to reside on the same machine as the StarTeam Server.

•
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Pre-Installation Setup
This section provides information about pre-installation setup considerations for running StarTeam Server on
Linux.

Environment Variables
Prior to installing StarTeam Server or StarTeam Server components, set the following environment variables:
•
•
•
•

JAVA_HOME environment variable to point to JRE or JDK 1.6.0_13 or above
NLS_LANG=AMERICAN_AMERICA.WE8MSWIN1252
ORACLE_HOME to point to Oracle home directory
PATH=$ORACLE_HOME/bin:$JAVA_HOME/bin:$PATH:

Permissions
Run the following command as root to make the StarTeam Server user account a member of the Oracle group
used to install the Oracle client:
/usr/sbin/usermod -a -G oinstall starteam_user_name
where oinstall is the default Oracle group name and starteam_user_name is the StarTeam Server user
account.

Installing StarTeam Server on Linux
1. Close all other applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the binary file using the command ./server.bin.
Note: When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use
as a parameter when running the installer. This step is necessary because Java VMs for non-Windows
operating systems are not bundled with the installers. If you experience any difficulties running the
./server.bin command, add the parameter LAX_VM and specify the path to your VM. For example:
./server.bin LAX_VM /usr/java/latest/jre/bin/java.
4. In the StarTeam Server splash screen, select the appropriate language and click OK.
5. In the Introduction dialog box, read the information and click Next.
6. If the ORACLE_HOME variable is not set in your environment, the Get Oracle Path dialog box will appear.
Browse to or type the path to the Oracle client installation and click Next.
7. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
8. In the Choose Install Set dialog box, select Typical, Compact, or Custom.
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•
•
•

Typical -- Installs StarTeam Server with the StarDraw sample server configuration and the StarTeam
online documentation in PDF format.
Compact -- Installs StarTeam Server with the minimum required options. Select this option if you do
not want to install the StarDraw sample server configuration.
Custom -- Enables you to choose the options you want to install. Recommended for advanced users.

9. Click Next.
10. For a custom installation only, the Choose Install Set dialog box will appear. Select (to install) or clear (to
bypass) the check boxes for the available options.
•
•

StarTeam Server -- If you use the custom installation to install something that was not installed during
a previous installation of StarTeam Server, you may choose to clear this check box.
Sample server configuration -- Clear this check box if you do not want to install the StarDraw sample
server configuration.

11. Click Next.
12. In the Choose Install Folder dialog box, click Choose... to browse to the installation folder (the default
location is /home/starteam/starteamserver2009).
13. Click Next.
14. Review the information in the Pre-Installation Summary dialog box and click Install.
15. In the Install Complete dialog box, click Done to quit the installer.

Server Administration
Use the Server Administration application to configure and manage each StarTeam Server.
To start the Server Administration application, use the ./serveradmin.sh command from the installation
directory. The shell script sets up the shared library path LD_LIBRARY_PATH before starting the Server
Administration application.

SELinux
If SELinux is enabled in your system, you might receive a message like the following one when you start either
the StarTeam Server or the Cache Agent, or when you invoke the starteamserver command line:
/root/starteamserver2008/libzlib.so: cannot restore segment prot after reloc: Permission denied
To avoid this problem, set the SELinux Enforcement mechanism to permissive.
If this approach is not an option for your organization, run the command chcon -t textrel_shlib_t
*.so from each of the following directories:
•
•
•

•
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The StarTeam Server installation directory.
$ORACLE_HOME/lib.
jrexx/lib/i386/client, where jrexx is the java runtime environment (jre) used by the starteam
server installation. If the server installation was performed by a root user, jrexx is installed in the directory
/opt/Borland/. If the server installation was performed by a standard user, jrexx is installed in the
home directory of the user.
The StarTeam Cache Agent installation directory.
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StarDraw
Micro Focus provides the sample database StarDraw with StarTeam Server. The StarTeam Server installation
procedure:
•
•

Creates the Samples directory and subdirectories under the installation directory and copies the sample
repository files into them.
Copies the Oracle export file stardraw.dat into the install_dir/starteamserver2009
R2/Samples/StarDraw_Repository/Database directory.

Using the StarDraw Sample Server Configuration
StarTeam provides a sample server configuration named StarDraw. It contains a Visual C++ sample application
and related materials. You can use the StarDraw sample repository to experiment with and learn more about
StarTeam.
During the Server installation procedure, the sample server configuration is installed as part of the Typical
installation and can be installed as part of the Custom installation.The installer creates the Sample by performing
the following actions:
•
•
•

Copies the stardraw.mdf database into the StarTeam Server
<version>\Samples\StarDraw_SSE2005\Database folder.
Copies sample files into the StarTeam Server
<version>\Samples\StarDraw_SSE2005\StarDraw\Archives folder and its subfolders.
Adds the new StarDraw server configuration to the starteam-server-configs.xml file. If a previous StarDraw
server configuration is defined in that file, its settings are updated for the new release’s version of StarDraw.
Important:
In the starteam-server-configs.xml file, the predefined value of ServerGuid for the StarDraw Repository
is:
be5ee3b0-c719-49c6-a1a1-f493764a03f5
Do not change this value. The StarDraw server configuration will not start if you modify the ServerGuid.

Use the StarDraw server configuration only for experimentation and training—never for live data.

Restoring the StarDraw Database Backup File
To restore the StarDraw database backup file on the Oracle database machine:
1. If you have not already done so, create the following on the Oracle database machine:
•
•

A database instance that will host the StarDraw database. StarDraw can share the database instance
with other databases.
A tablespace named stardraw on this instance. Following is a sample create tablespace command:
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Create tablespace stardraw datafile 'c:\stardraw.dbf' size 400m autoextend
on next 10k maxsize 32767m extent management local
2. If StarTeam Server for Linux is on a different machine than your Oracle database, copy the file
stardraw.dat to the database machine. Using SQLplus, create an Oracle virtual directory that points to
the location of stardraw.dat. For example:
•
Windows

•

SQL> create or replace directory test_dir as
'C:\stardraw_dir';
SQL> grant read,write on directory test_dir to public;

where stardraw_dir is the folder that contains the file stardraw.dat.
•
Unix
•

SQL> create or replace directory test_dir as
'install_dir/starteamserver2009/Samples/StarDraw_Repository/
Database';
SQL> grant read,write on directory test_dir to public;

3. Run the following command (logged in as your Oracle user if your Oracle database is on Linux):
impdp system/password directory=test_dir dumpfile=stardraw.dat
logfile=stardraw.log
where password is the password for the "system" Oracle schema user, and test_dir is the Oracle virtual
directory created in step 2.
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Installing StarTeamMPX on Windows
This chapter provides a brief overview of StarTeamMPX and explains how to install each of the StarTeamMPX
components on supported Windows systems. StarTeamMPX Event Transmitter and Message Broker are
included with the StarTeam Enterprise package.You must license the StarTeam Enterprise Advantage package
to use StarTeamMPX File Transmitter and Cache Agent.
The StarTeamMPX Administrator’s Guide provides comprehensive information about StarTeamMPX including
it’s architecture, configuration, and usage.
Note: StarTeamMPX and what appears on the screen during its installation are only in English.

About StarTeamMPX
StarTeamMPX is a framework for publish/subscribe messaging that improves the performance of the clients
and extends the scalability of server configurations. It contains both common and application-specific components
that together provide advanced messaging capabilities.
With StarTeamMPX, changes to the server configuration’s repository are broadcast in an encrypted format to
StarTeam clients and StarTeamMPX Cache Agents through a publish/subscribe channel. For example, the
StarTeam Event Transmitter broadcasts encrypted messages about changes to objects, such as change
requests, and the StarTeam File Transmitter broadcasts archive files.
Caching modules automatically capture events that a client subscribes to. This reduces the client’s need to
send refresh requests to the server and improves client response times for the user.
StarTeamMPX Cache Agents can be installed and configured to cache both item properties and file contents.
This speeds up data access by placing the data in locations that are network near to the members of globally
distributed teams. While StarTeamMPX Cache Agents rely on messages and data transmitted by the Event
Transmitter and the File Transmitter, they also serve other StarTeamMPX clients, such as the Cross-Platform
Client, which retrieve data from the Cache Agent instead of the Server itself. StarTeamMPX Cache Agents
are available only with StarTeam Enterprise Advantage.

StarTeamMPX Components
Most of StarTeamMPX components described below are installed separately. The transmitters are included
in the Server installation.
•

StarTeamMPX Transmitters - There are two types of transmitters: an Event Transmitter and a File
Transmitter. Both are installed along with the server.
•

Event Transmitter - The Event Transmitter receives events of interest to StarTeam clients. The Event
Transmitter formats the event information it receives into XML messages, encrypts them, and publishes
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them to a Message Broker. Messages are assigned topics so that they can be distributed to clients
interested in the accompanying content (project/view, item type, event type, etc.).
•

•

File Transmitter - The File Transmitter broadcasts file contents and item properties to one or more
Remote Cache Agents by way of a Message Broker.

StarTeamMPX Message Broker - The Message Broker is a publish/subscribe messaging engine that
broadcasts messages to subscriber components on a topic basis. It is a stand-alone process that can run
on a separate computer to off load network processing overhead in high-volume environments.The Message
Broker broadcasts messages to each of its recipients using TCP/IP messaging.
The Message Broker receives encrypted XML messages from the Event Transmitter or encrypted data
from the File Transmitter, and forwards them to the appropriate clients. Information is sent from a Message
Broker directly to clients that have subscribed to that Message Broker by way of a TCP/IP connection profile.
Each MPX-enabled server configuration has one or two Root Message Brokers. One or more Remote
Message Brokers can be distributed throughout the enterprise.

•

StarTeamMPX Cache Agent - Cache Agent adds persistent data caching. Each MPX-enabled server
configuration can have one Root Cache Agent. One or more Remote Cache Agents can be distributed
throughout the enterprise. Often Remote Message Brokers and Remote Cache Agents are paired.
A Root Cache Agent operates directly on the server configuration’s vault and cache. A Root Cache Agent
handles requests forwarded from Remote Cache Agents for missing files and provides “catch-up” assistance
for Remote Cache Agents after network or process outages.
Cache Agent-aware StarTeam clients can fetch data from any available Cache Agent. By using “network-near”
Cache Agents, clients can improve file check-out performance and reduce their demands on the Server.
This frees server resources for additional tasks and users.

Generating Transmitter XML Files
When the transmitters are installed as part of a Server installation, the transmitter template files
(MPXEventTransmitterTemplate.xml and MPXFileTransmitterTemplate.xml) are installed in the EventServices
folder, a subfolder of the server’s installation folder.
When existing configurations are in place at the time of the installation, a configuration-specific set of transmitter
XML files is created automatically for each existing configuration. The configuration-specific XML files
(MPXEventTransmitter.xml and MPXFileTransmitter.xml) are created by copying the XML template
files to a configuration-specific subfolder of the EventServices folder. For example, the StarDraw sample server
configuration’s existence results in a subfolder of the EventServices folder named StarDraw.
When a new configuration is defined, a set of configuration-specific XML files may be generated automatically
depending on how the configuration is created:
•

•
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If you create a new configuration by using the Server Administration tool, a configuration-specific
MPXEventTransmitter.xml and FileTransmitter.xml will be created automatically. The utility does this by
copying the current XML template files to the appropriate configuration-specific subfolder of the EventServices
folder and removing “Template” from their names.
If you create a new configuration by using Server’s command-line interface, no configuration-specific XML
files are created. If you want the new configuration to be MPX-enabled, you need to create the
configuration-specific subfolder of the EventServices folder. The configuration subfolder’s name must be
the same as the configuration name. Then manually copy the XML template files to the appropriate
configuration-specific subfolder of the EventServices folder and remove “Template” from their names.
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To edit the new XML files, see the section “Understanding Connection Profiles” in the StarTeamMPX
Administrator’s Guide for more information on configuration-specific and XML template files.

System Requirements for StarTeamMPX Message Brokers
and Cache Agents
Server must be installed prior to installing Message Brokers and Cache Agents. StarTeamMPX transmitters
have the same system requirements as the Server because they are part of that component.
Where you install Message Brokers and Cache Agents depends on your user distribution, networks, and
purposes.
See the StarTeamMPX Administrator’s Guide which is available on the Borland StarTeam ➤ StarTeam
Server <version> ➤ Documentation menu for more information about configuring StarTeamMPX.

Supported Operating Systems
The following operating systems are supported for the Message Broker and Cache Agent components with
this release of StarTeamMPX:
•
•
•

Microsoft Windows Server 2003 R2 SP2 (32-bit)
Microsoft Windows Server 2008 (32- and 64-bit)
Microsoft Windows Server 2008 R2 (64-bit)
Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer
will return an error upon attempting to install the Java VM.

Hardware Recommendations
Number of Peak Users

Recommended Configuration

less than 100

32-bit, dual-core systems with 4GB of memory

100 - 200

32-bit, quad-core systems with 4-8GB of memory

more than 200

64-bit, quad-core systems with 8-16GB of memory

For the Message Broker, the number of peak users is typically lower than the number of peak users connected
to the StarTeam server since multiple Message Brokers are used in medium-to-large deployments. The number
of peak users connected to a Cache Agent is significantly lower because Cache Agents are only used in short
bursts. As a result, less hardware resources are typically required to support the Message Broker and Cache
Agent compared to the StarTeam Server. Moreover, for a given geographic location, the Message Broker and
Cache Agent are typically deployed on the same machine.

Installing Message Brokers and Cache Agents Overview
StarTeamMPX Message Broker and Cache Agent are installed separately from Server and after Server.
Installation instructions for each of these products is included in the following sections.
For more information about StarTeamMPX, see the StarTeamMPX Administrator’s Guide.
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Installing the Message Broker
The root Message Broker can be installed on the same computer where the Server is installed, or it can be
installed on a network-near computer. At least one Message Broker must be installed in your environment to
provide messaging services for an MPX-enabled Server. As described in "Understanding Clouds" in the
StarTeamMPX Administrator’s Guide, you may want to install more than one Message Broker to meet your
needs.
Note: Note that the Setup program assumes the Message Broker will use the default port number 5101.
If you want to use a different endpoint, edit the file STMessageBroker68.ini after the setup program
completes. For more information, see "Changing the Endpoint of a Message Broker" in the StarTeamMPX
Administrator’s Guide.
To install the Message Broker on Windows:
1. On the computer where you wish to install the Message Broker, log on as the administrator or as a user
with administrative privileges.
2. Run the downloaded installer.
3. In the Introduction dialog box, read the information, and click Next.
4. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the License Agreement, select I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
5. In the Service Start Options dialog box, select the appropriate radio button to specify whether you want to
install the Message Broker as an automatic or a manual service, and click Next.
6. In the Choose Install Folder dialog box, click Choose… to browse to the desired location for the installation
folder.
The default Installation location is C:\Program Files\Borland\Message Broker 6.8. The following
options are provided.
•
•

To change the default location, click Choose...
To restore the default location, click Restore Default Folder.

Click Next to continue.
7. In the Choose Shortcut Folder dialog box, specify where you would like to create product icons. The
default location is C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeamMPX Message Broker 6.8.
Click Next.
8. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box and
click Next.
9. In the Install Complete dialog box, click Done.

Upgrading the Message Broker
The 6.8 Message Broker that ships with Server 2009 and later has several fixes, making it the only Message
Broker that you will want to use with any release mentioned in this section. Install the 6.8 Message Broker
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from Server 2009 over any older version of the 6.8 Message Broker and upgrade any installation of 6.7 Message
Brokers. All Message Broker versions are interoperable; consequently, you can upgrade them one at a time.
To upgrade to Message Broker 6.8, we recommend the following procedure:
1. Install Message Broker 6.8 on the same machine as Message Broker 6.7, letting the installer set it up as
an auto-start service.
2. If you have customized the file STMessageBroker67.ini, copy it to the Message Broker 6.8 installation
folder with the new name (STMessageBroker68.ini) so that you can reuse that file with Message Broker
6.8.
3. Stop Message Broker 6.7, and set the corresponding service (StarTeamMPX Message Broker 6.7) to
Manual so it does not automatically start again.
4. Start Message Broker 6.8.
5. Determine that everything is working as expected, and then uninstall Message Broker 6.7.
Multiple releases of Message Broker can run on the same machine if each uses its own port. You cannot
start both the 6.7 and 6.8 Message Brokers at the same time if they are on the same machine and listening
on the same port. Doing so causes a race condition, and the second one to start will fail.

Installing a Cache Agent
The following sections cover upgrade issues, pre-installation issues, and explain how to install a Cache Agent.
You need to install Cache Agent only once on any computer that will use one or more Cache Agents. You run
as many instances of Cache Agent as you need, each with a different and appropriate XML file.
The default XML file for a Root Cache Agent is RootCAConfig.xml. The default XML file for a Remote Cache
Agent is RemoteCAConfig.xml. As you install Cache Agent, you also set up an initial Cache Agent
configuration file, so you must select either a Root or Remote Cache Agent during the installation. This does
not stop you from creating another configuration file for the same or a different type of Cache Agent later on
that same computer.

Upgrading the Cache Agent
The Cache Agent can be installed on a machine with a previous release.
Note: The goal is to transition StarTeam server configurations from the older to the newer release.
The Cache Agent can be run as either an application or a service.You can run multiple Cache Agent instances
on the same machine, but each needs its own configuration file.
By default, the installation creates a manual Cache Agent service for your convenience. If the installation
detects that a Cache Agent service (for example,
HKEY_LOCAL_MACHINES\SYSTEM\ControlSet001\Services\CacheAgentService) already exists
and is registered, the installation does not set up a service. A warning advises:
•

•

If the existing Cache Agent service is no longer needed, uninstall the previous Cache Agent release or use
the previous release to run "CacheAgentService ‘-unregister" from a console window to unregister the
existing Cache Agent. Note that this is optional—the older release can remain, including the services created
for it.
Create an appropriate configuration file for each Cache Agent service desired for the release just installed.
You can reuse configuration files from the previous release of Cache Agent by copying them to the new
location. You might need to rename them for use with multiple Cache Agent instances.
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•

•

Using the release just installed, run "CacheAgentService - register" from a console window for each Cache
Agent service desired. Note that the "-name" parameter is used to define a unique service name for each
new service created.
If an older Cache Agent is installed, you are not asked whether you are installing a root or remote cache
agent and are not asked for any configuration information. The sample files
(SampleRemoteCacheAgentConfig.xml and SampleRootCacheAgentConfig.xml) are installed
(as always), but neither the RootCAConfig.xml nor the RemoteCAConfig.xml file is created.

See the StarTeamMPX Administrator’s Guide available on the Borland StarTeam ➤ StarTeam Server
<version> ➤ Documentation menu for more information about configuring Cache Agents.

Before Installing a Cache Agent
When installing a Cache Agent that will be used as a Root Cache Agent, Server must be installed first. After
you have installed Server, you can install the other components in any order.
The following is a recommendation for installing StarTeamMPX components:
1. Install Server. The Event and File Transmitters are installed automatically with Server.
2. Install the StarTeam Message Broker. You can run multiple instances of the Message Broker.
3. Install the Root Cache Agent. You need to install it only once per machine, even when that machine has
more than one server configuration. You run multiple instances to support multiple Server configurations.
Each server configuration must have its own root cache agent instance.
4. Install the Remote Cache Agent. This is the same installer as the Root Cache Agent.
The Remote Cache Agents can use the same Message Broker as the Root Cache Agent, but multiple
Message Brokers are suggested for distributed teams, especially over distances. In practice, Remote Cache
Agents usually use Remote Message Brokers.
Before you start a Root Cache Agent:
a) Start each server configuration that you will use with Cache Agent. Doing this causes the File Transmitter
to generate or upgrade a CacheJournal.dat file for each configuration.
b) (Optional) Modify the MaxJournalAge parameter’s value in the FileTransmitter.xml file to represent
the maximum number of days for which records will be kept within the Journal file. The pre-configured
value is 180 days. Note that the Journal file is “trimmed” of expired records (those whose age exceeds
the MaxJournalAge value) only when the server configuration is started.

Installing a Cache Agent
Whether a Cache Agent operates as a Root Cache Agent or a Remote Cache Agent is determined solely by
its configuration. The installation of the Cache Agent is similar in both cases except for consideration of the
computer on which to install it:
•

•
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The Root Cache Agent requires access to the vault for the server configuration that it services. Consequently,
it is usually installed on the same computer as the Server. Alternatively, if it can be installed on a network-near
computer to prevent the Root Cache Agent from competing for CPU or network I/O with the corresponding
server configuration. However, this requires it to access the vault files and the CacheJournal.dat file by way
of a shared network drive, so use this option only when a high-speed network is in place.
Remote Cache Agents should be installed in each geographic location that can benefit from local data
access. One approach is to install a Cache Agent in each network environment that local users can access
over a highspeed LAN. (For example: Install two Remote Cache Agents at headquarters, one each for
engineering and QA; install one at each regional office.) Another beneficial use of the Cache Agent is to
install an instance on a computer dedicated to a check-out intensive application such as a build utility. There
is no limit on the number of Cache Agents that can be installed throughout an enterprise. However, keep
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in mind that each Cache Agent requires access to a Message Broker. For more information about clouds,
see “Understanding Clouds” in the StarTeamMPX Administrator’s Guide.
To install a Root Cache Agent or Remote Cache Agent on Windows:
1. On the computer where you wish to install the Cache Agent, log on as the administrator or as a user with
administrative privileges.
2. Run the downloaded installer.
3. Select a language from the drop-down list, and click OK.
4. In the Introduction dialog box, read the information, and then click Next.
5. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c) Click Next.
6. Choose an installation folder.The default installation path is C:\Program Files\Borland\StarTeamMPX
Cache Agent <version>.
7. Choose a Root Cache Agent or Remote Cache Agent installation.
8. For a Root Cache Agent installation, you are prompted to enter:
Message Broker Address: Enter the host name or address of the Message Broker that the Root Cache
Agent will use to communicate with other Cache Agents and clients. This value can optionally include the
protocol prefix (tcp:) and port number suffix (:1234). The port number must be provided if the Message
Broker is not using the default port of 5101. For example: tcp:MBServer1:5123
Server Cache folder: Click Choose to browse to the folder path that contains the vault cache of the server
configuration that the Cache Agent will serve. This path must be relative to the computer on which the Root
Cache Agent is being installed.
9. For a Remote Cache Agent installation, you are prompted to enter:
Message Broker Address: Enter the host name or IP address of the Message Broker that the Remote
Cache Agent will use to receive file content messages and to communicate with other Cache Agents and
clients. A Remote Cache Agent should be configured to use a Message Broker and the tcp: address.
This option is described in more detail in “Configuring a Remote Cache Agent” in the in the StarTeamMPX
Administrator’s Guide.
10. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button set
to C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeamMPX Cache Agent <version>).
11. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Preinstallation Summary dialog box and
click Install.
12. In the Install Complete dialog box, click Done.

After Installing Cache Agent
Depending upon your environment, you may have to perform additional steps to use the Cache Agent:
For any Cache Agent:
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•
•

The Cache Agent installer installs both CacheAgentService.exe and CacheAgentApp.exe so you can run
Cache Agent as either a service or a console application.
CacheAgentService is configured as a “Manual” start service.You may want to change the start type to
“Auto” so that the Cache Agent will start automatically thereafter. To change the start type to “Auto”, use
the Control Panel Services interface or unregister and re-register the service. See “Running Cache Agent
on Windows” in the StarTeamMPX Administrator’s Guide for more information.

If you installed a Root Cache Agent:
•

The default configuration file for a Root Cache Agent is RootCAConfig.xml. It may need to some modification.
See “Configuring a Root Cache Agent” in the StarTeamMPX Administrator’s Guide.

If you installed a Remote Cache Agent:
•

The default configuration file for a Remote Cache Agent is RemoteCAConfig.xml. It needs some modification
for your environment. It is configured with a sample configuration file that “tiers” the Cache Agent to the
Root Cache Agent for the StarDraw sample configuration (even if it does not actually exist). See “Configuring
a Remote Cache Agent in the StarTeamMPX Administrator’s Guide.

Uninstalling Message Brokers and Cache Agents
Each time you install a Message Broker or Cache Agent, an Uninstall program shortcut is created for that
component. The Uninstall programs enable you to remove the Message Broker and/or Cache Agents from
your computer. Your Server installation, server configurations, and repositories are unaffected.
The uninstall program for the server leaves the transmitter template files and each configuration's transmitter
XML files intact. A subsequent installation will not overwrite these files.
The StarTeamMPX Services Uninstall program leaves the STMessageBroker68.ini file intact. If you later
reinstall these services, this file will not be replaced by the new installation.
Note: StarTeamMPX uses InstallAnywhere for installation and uninstallation. If you encounter one of the
following Java VM errors when uninstalling this product on a Windows operating system, you may need
to install JRE 1.6.0_29 or earlier from the Sun website.
Uninstall errors:
•
•

50

"Can't launch executable. Could not find a suitable Java Virtual machine on your system."
"Windows error 3 occurred while loading the Java VM."
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Installing StarTeamMPX on Linux
This chapter explains how to install StarTeamMPX on Linux. For a brief overview about StarTeamMPX, see
Installing StarTeamMPX on Windows on page 43.

Installing StarTeam Message Broker on Linux
1. Close all other applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the binary file using the command ./mpxservices.bin.
Note: When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use
as a parameter when running the installer. This step is necessary because Java VMs for non-Windows
operating systems are not bundled with the installers. If you experience any difficulties when running
the command ./mpxservices.bin, add the parameter LAX_VM and specify the path to your VM.
For example: ./mpxservices.bin LAX_VM /usr/java/latest/jre/bin/java.
Note: If the OpenSSL toolkit (openssl097a-0.9.7a-9.i386.rpm) and the Compatibility standard
C++ libraries (compat-libstdc++-33-3.2.3-61.i386.rpm) are not installed, the StarTeamMPX
Services installer will prompt you to install them before continuing with the installation of StarTeam
Message Broker.
4. In the Introduction dialog box, read the information and click Next.
5. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
6. In the Choose Install Folder dialog box, browse to or type the path to the installation folder (the default
location is /opt/messagebroker68).
7. Click Next.
8. In the Choose Link Folder dialog box, specify whether to create links in your home folder, to create them
in another location, or to not create them at all.
9. Click Next.
10. Review the information in the Pre-Installation Summary dialog box and click Install.
11. In the Install Complete dialog box, click Done to quit the installer.
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Installing a StarTeamMPX Root or Remote Cache Agent on
Linux
1. Close all other applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the binary file using the command ./ca.bin.
Note: When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use
as a parameter when running the installer. This step is necessary because Java VMs for non-Windows
operating systems are not bundled with the installers. If you experience any difficulties when running
the command ./ca.bin, add the parameter LAX_VM and specify the path to your VM. For example:
./ca.bin LAX_VM /usr/java/latest/jre/bin/java.
4. In the Introduction dialog box, read the information and click Next.
5. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
6. In the Choose Install Folder dialog box, browse to or type the path to the installation folder (the default
location is /home/starteam/cacheagent2009R2).
7. Click Next.
8. In the Choose Cache Agent Type dialog box, select the Cache Agent type you wish to install and click
Next:
•

•

Root Cache Agent -- Each StarTeam configuration can have one Root Cache Agent. You can install
it on the same machine as StarTeam Server or on a separate machine that has access to the
configuration's vault cache folder.
Remote Cache Agent -- You can install any number of Remote Cache Agents throughout your
organization. Typically, one Remote Cache Agent must be installed in each geographic region. Each
Remote Cache Agent is usually chained or tiered to one or more Root Cache Agents.

9. If the Cache Agent type is Root, use the Get Root Cache Agent Settings dialog box to perform the following
steps:
a) Specify the address of the Message Broker to be used.
b) Browse to or type the path to the repository of the StarTeam server configuration. The default location
is /home/starteam/starteamserver2009R2/Samples/StarDraw_Repository/.
c) Click Next.
If the Cache Agent type is Remote, use the Get Remote Cache Agent Settings dialog box to perform the
following steps:
1. Specify the address of the Message Broker to be used.
2. Specify the StarTeam server configuration GUID.
3. Click Next.
10. In the Choose Link Folder dialog box, specify whether to create links in your home folder, to create them
in another location, or to not create them at all.
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11. Click Next.
12. Review the information in the Pre-Installation Summary dialog box and click Install.
13. In the Install Complete dialog box, click Done to quit the installer.
In order to start the Cache Agent, set the environment variable LD_LIBRARY_PATH to point to the lib folder
of the Oracle home directory.
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Installing the Cross-Platform Client
This chapter explains how to install the Cross-Platform Client on Windows and other platforms.
Check Micro Focus SupportLine (http://supportline.microfocus.com) for the latest patches for each client.

System Requirements for the Cross-Platform Client
The Cross-Platform Client can be installed on operating systems that support Sun Microsystems Java Virtual
Machine 1.6.0_29. The Cross-Platform Client has been tested on the following systems:
System Area

Requirement

Platforms (32-bit)

Windows XP Professional SP3, 32-bit
Windows Vista SP1, 32-bit
Windows 7, 32-bit
Solaris Sparc 10
Red Hat Enterprise Linux (WS) 5.1

Processor

32-bit dual core

RAM

2 GB minimum

Hard disk space

200 MB to install the application
Note: Sufficient disk space is required for your working
files. The amount will vary depending on your use of
the product.

Display

SVGA, high color mode, 1024x768
Recommended resolution: 1280x1024 or more

Before Installing the Cross-Platform Client
Before you install the Cross-Platform Client, make sure your computer system meets the minimum requirements.
For more information, see System Requirements for the Cross-Platform Client on page 54
StarTeam supports compatibility between clients and servers which are either one release ahead or behind
one another.This support is provided for your convenience in implementing your upgrades to the latest release.
Some functionality may only be available in the latest release.You will achieve best performance by upgrading
your clients and servers to the same release.

54

| Installing the Cross-Platform Client

While some flexibility in client-server release combinations is allowed, StarTeam servers do not support
connections from clients using an SDK older than StarTeam SDK 2006. This supported connection release
will change in subsequent releases.
Important: You must be a local administrator on the target computer to install StarTeam products.

Setting up Default Personal Options
If, during a custom installation of the StarTeam Server for Windows, you choose the Client Setup option, the
installation files for StarTeam Cross-Platform Client were copied to a location designated by you and accessible
to all users. Users can install from that location. One of the benefits of this arrangement is that each new user
can be given a set of initial personal options, selected by you, instead of using the usual default StarTeam
Cross-Platform Client personal options. For example, if these users use Change Requests more often than
any other StarTeam tab, you can make the Change Requests tab the first, or only, tab that the client displays.
To customize default personal options, create a file named starteam-client-default-options.xml
and place it in the Client Setup folder. During the StarTeam Cross-Platform Client installation, the default
personal options file you created is copied to All Users\Application Data\Borland\StarTeam where
it becomes a template for the starteam-client-options.xml file created by the Cross-Platform Client
when a user starts it for the first time. Existing client users can use your personal options before starting the
client. The client will not overwrite the existing starteam-client-options.xml.
To provide all new users of the Cross-Platform Client with the same initial set of personal options:
1. Perform a custom installation of Server while selecting the Client Setup check box, so that the disk image
for StarTeam Cross-Platform Client is installed in the Client Setup folder, a child folder of the Server
installation folder.
2. Make sure that this folder is one that all team members can access.
3. Install the Cross-Platform Client on only one computer.
4. Set the personal options. See the StarTeam online help for details.
5. Notice that you now have a file named starteam-client-options.xml in the user profile folder. On Windows,
this is usually in the C:\Documents and Settings\user\Application Data\Borland\StarTeam
folder.
6. Copy this file to the Client Setup folder.
7. Rename this file starteam-client-default-options.xml.
8. Instruct users to install the Cross-Platform Client from the Client Setup folder.

Installing the Cross-Platform Client
You can install the Cross-Platform Client on Windows or other operating systems such as Solaris and Linux
systems.
To learn to use the Cross-Platform Client, refer to the online help or the PDF documentation available from
the StarTeam Cross-Platform Client <version> ➤ Documentation submenu.

Installing on Windows
To install the Cross-Platform Client on Windows:
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1.
2.
3.
4.
5.

Close all running Windows applications.
Run the downloaded installer.
Select a language from the drop-down list, and click OK.
In the Introduction dialog box, read the information, and click Next.
In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c) Click Next.

6. In the Choose Install Set dialog box:
a) Select the Typical, Compact, or Custom button.
•
•
•

Typical installs the StarTeam client, its user manuals, its online help, and the StarTeam Toolbar.
The toolbar stores logon information making it easier to log on.
Compact installs only the StarTeam client, its user manuals, and its online help.
Custom allows you to select what is installed. This is the only way to install the StarTeam
Administration tool to use on a client workstation. When installed as part of the client, you can do
only remote server administration. Click Next.

b) If you selected a Custom install set, select or clear the check boxes for the parts you do and do not want
to install. The custom options are:
•
•
•

Application
StarTeam Toolbar
Server Administration

7. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the installation
folder. The default location is C:\Program Files\Borland\StarTeam Cross-Platform Client
<version>.
8. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeam Cross-Platform Client <version>).
9. In the Pre-installation Summary dialog box, do one of the following:
•
•

Review the settings and click Install.
Review the settings and click Previous one or more times if you want to change the installation options.
Then return to the Pre-installation Summary dialog box and click Install.

10. In the Install Complete dialog box, click Done.
The Cross-Platform Client is installed in the specified folder, and the
StarTeam_Cross-Platform_Client_<version>_InstallLog.log file in that folder documents
what happened during the installation process.

Installing on Linux or Solaris
To install the Cross-Platform Client on Linux or Solaris:
1. Extract the downloaded Linux or Solaris installation package.
2. Run the StarTeamCP.bin file with the parameter LAX_VM to invoke the installer. For example,
./StarTeamCP.bin LAX_VM /LAX_VM /usr/java/latest/jre/bin/java.
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Important: You must specify which Java VM to use when installing on non-Windows operating systems
since the installers are Java based, and are not bundled with a Java VM. This also applies to Server,
EventTransmitter, MPX and Cache Agent (for example, server.bin, ca.bin, mpxserver.bin, and
mpxservices.bin).
3. Follow the directions on your screen.
4. After installation, run the StarTeamCP executable located in the user_home_directory\StarTeam
CP_<version> folder, or use the shortcut with the same name located in the directory selected during
installation.

Installing on Other Platforms
To install the Cross-Platform Client on other platforms, use the Universal installation:
1. Extract the downloaded Universal installation package.
2. Use the CD command to reach the installation's ./bin folder and run the setup script.This creates executable
scripts in the same directory. Start StarTeamCP by running the "starteam" script.

Automating Cross-Platform Client Installations
On Windows operating systems, a silent install allows you to do multiple client installations at one time. You
can run the client installer in a “silent” mode from the command line by adding the -i parameter to the command.
Alternatively, you can point to a text file called Installer.properties which includes the directive
INSTALLER_UI=silent.
The Installer.properties file can also specify parameters to pass to the installer, such as the destination
client installation folder, the root folder for the SDK installation, which components to install, and whether or
not a restart is needed.

Performing a Silent Install
Note: It is important to install the StarTeam client using a user that is an administrator on the computer.
You can run the client installer in a “silent” mode from the command line with one of the following:
•
•

The default values for installation options
Values that you set for installation options

To set your own values for installation options:
1. Create a text file named installer.properties to contain the installation options to be set.
2. Add options and their values to the file. Each installer option is represented by a parameter followed by an
equal sign followed by the value for the parameter. Each parameter is on a separate line in the file.
The first line must be INSTALLER_UI=silent. Any options from the table that are not specified will use
their default values.
The following table provides other possible silent installation options for the installer.prperties file.
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Parameters

Description

USER_INSTALL_DIR=

Client installation path. The default is C:\\Program

Files\\Borland\\StarTeam Cross-Platform
Client <version>.
ST_SDKROOT=

SDK installation path. The default is C:\\Program
Files\\Borland.

RESTART_NEEDED=NO

Set this value to NO to control reboot after SDK installation.

USER_REQUESTED_RESTART=NO

Set this value to NO to control user message about rebooting
after CPC installation.

CHOSEN_INSTALL_SET=

Type of installation (Typical or Compact. Custom is not
supported for a silent installation). The default is Typical.

Important: Double backslashes are required in path specifications.
3. Run the installer downloaded for Windows from the command line in one of the following ways:
•
•
•

Followed by -I silent (to use the default installation options with no rebooting).
Followed by -f path_to_installer.properties_file.
Without a parameter if the instllation.properties file exists and is in the same folder as the
downloaded installer.

Additional Customizations
Server list and personal option files may be included with the silent installations.
These files are located in the local settings of the currently logged on user (for example, C:\Documents and
Settings\user_ID\Application Data\Borland\StarTeam). Once these files contain the desired
values (use a StarTeam Client to add the servers and set the personal options), copy these files to the same
location as the Installer.properties file. Rename these files as shown in the table below.
Original File Name

Description

Installation File Name

starteamservers.xml

Servers at a site

server .xml

starteam-client-options.xml

StarTeam personal options

starteam-client-default-options.xml

The starteam-client-default-options.xml file will be copied to the User local home settings (for
example, C:\Documents and Settings\user_home\Application Data\Borland\StarTeam). If
the starteam-client-default-options.xml file is included, the installation will overwrite this file if it
already exists. This file will be used as a template for future new instances of the
starteam-client-options.xml file in the user specific local settings. Existing instances of
starteam-client-options.xml will not be overwritten.
The server.xml file will be copied to the installation user’s local settings if the starteamservers.xml does
not already exist. The starteam-server.xml file will not be overwritten. This will only affect the server
settings of the user who was currently logged on to the computer when the installation occurred.
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Uninstalling the Cross-Platform Client on Windows
The Cross-Platform Client uses InstallAnywhere for installing and uninstalling. If you encounter one of the
following Java VM errors when uninstalling this product on a Windows system (such as 2003 or XP Pro), you
may need to install JRE 1.6.0_29 or earlier from the Sun website.
Uninstall errors:
•
•

"Can't launch executable. Could not find a suitable Java Virtual machine on your system."
"Windows error 3 occurred while loading the Java VM."

Installing StarTeam Integrations
You may receive an email that includes URLs for downloads of all StarTeam components for your StarTeam
edition. Among those URLs are download links for starteam-integrations.zip and
starteam-integrations.tar.gz. These files contain the free StarTeam integrations. The StarTeam
Synchronizer for HP Quality Center must be purchased separately.
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Installing and Configuring the Web Server
The Borland StarTeam Web Server provides Web Client access to one or more StarTeam servers through
supported browsers.
This chapter explains how to install the Web Server and specify the StarTeam servers, item types, projects,
and views that will be available to Web Client users.

System Requirements
The following table shows the system requirements for the StarTeam Web Server and the StarTeam Web
Client.
System Area

Requirement

Web Server

Operating System: Microsoft Windows Server 2008 R2 SP1, 64-bit
Processor: 64-bit quad core
RAM: 8 GB minimum
Hard Disk Space: 200 MB to install the application

Web Client

Browsers:
•
•

Microsoft Internet Explorer 8 and 9 on Windows
Firefox 4 on Windows and Linux

Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer
will return an error upon attempting to install the Java VM.

Performance and Scalability
A maximum of 200 active concurrent Web Client users can be supported on one instance of the Web Server.
If no more than 200 users are actively performing operations in the Web Client, the number of concurrent users
may be higher. To support more than 200 active concurrent users, put them on another instance of the Web
Server.
An instance of the Web Server can provide access to thirty or more StarTeam views. The number of views
supported is impacted by the size of the views and the amount of memory provided to the process. To increase
the amount of memory made available to the Web Server, see Changing the Memory Allocated to the Web
Server on page 71.
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Installing the Web Server
The user installing and running the StarTeam Web Server on Windows Server 2008 must have local
administrative privileges.
1.
2.
3.
4.
5.

Close all running Windows applications.
Run the downloaded installer.
Select a language from the drop-down list box, and click OK.
In the Introduction dialog box, read the information, and click Next.
In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.

6. In the Choose Install Folder dialog box, click Choose… to browse to the desired location for the installation
folder.
The default Installation location is C:\Program Files\Borland\StarTeam <version> Web Server.
The following options are provided.
•
•

To change the default location, click Choose...
To restore the default location, click Restore Default Folder.

Click Next to continue.
7. In the Choose Shortcut Folder dialog box, specify where you would like to create product icons. The
default location is C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Borland
StarTeam\StarTeam <version> Web Server.
Click Next.
8. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box and
click Next.
9. In the Install Complete dialog box, click Done.

Logging on to the Web Server
1. From the Windows Start Menu, choose Borland StarTeam ➤ StarTeam <version> Web Server ➤ Start
Web Server.
The Tomcat Console opens and starts the Web Server.
2. Open a supported browser and enter the following URL in the address bar:
http://<hostname>:<port>/BorlandStarTeam/BorlandStarTeamAdmin.jsp. <hostname> is
the name of the computer where the Web server is running and <port> is the TCP/IP port number used
by the Web server. When typing the hostname and port, do not use the angle brackets.
The Web Server logon page opens.
3. When logging on for the first time, type Administrator in both the User name and Password fields.
The password is case sensitive.
4. Click OK.
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The Administrator Panel page opens.

Changing the Web Server Administrator User Name and
Password
The Web Server has one user account for Web server administration. It is recommended to change the user
name and password instead of using the default values for these two properties. Even though the Borland
StarTeam Web Server Administrator has the same default user name and password as the Borland StarTeam
Server Administrator, these are unrelated user accounts.
1. In the Administration Panel, type the new user name in the User name text box.
2. Type the new password in the Password text box and again in the Confirm Password text box.
3. In Dynamic Cache Timeout, enter the length of time (in minutes) when a view will remain in memory before
being removed. The default value is 15 minutes.
The view is removed only if no one accesses it within the timeout period defined.
4. Click Save.
When changes to the configuration are saved, the changes are applied dynamically. The Web Server
process monitors the file for changes and applies all changes that are made.

Adding a StarTeam Server Configuration to the Web Server
The Borland StarTeam Web Server can only connect to a Borland StarTeam Server configuration that supports
MPX, and MPX must be running.
Perform the following steps to add a server configuration to the Available Servers folder tree and specify the
Server's item types, projects, and views that will be available to Web Client users.
1. Type a unique, easy-to-remember description in the Description text box. It is not case-sensitive and can
contain colons (:).
Note: This description is the name used in the Web Client.
2. Type the server configuration's computer name or IP address in the Address text box.
3. Type the endpoint (TCP/IP port number) associated with the protocol in the Port text box.
4. Type your User name and Password in the appropriate text boxes.
Note: The specified user must have administrative rights on the server configuration.
5. Click Add Server to Selected Servers.
The server configuration will be added to the Available Servers folder tree with its check box checked by
default, as only checked entries can be made available to Web Client users.
Note: Web Server Administrators can make a server configuration unavailable to Web Client users
by clearing its check box.
6. Under the server configuration's Available Types, check the item types to be made available to Web Client
users.
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7. Under the server configuration's Available Projects, select the StarTeam projects to be made available
to Web Client users using one of the following options for each project:
•
•

Select Allow All Views under a project in the server tree. When selected, all views for the project are
allowed to be used and cached and the other view node options are disabled.
Under a project's Available Views, select the views to be made available to Web Client users.
Tip: The number of available views affects the amount of memory needed for the Web Server
process. If the Web Server is running out of memory, set the disable_sdk_sessions value to
true in the file located in /apache-tomcat-5.5.27/
webapps/BorlandStarTeam/config/server.xml in the installation folder. This will enable
the Web Server to start without loading the available views, and you can then decrease the
configuration size.

8. Optionally: To make all views for a server available, select a server in the server tree and click Allow all
Views for Selected Server.
All projects for the server will have the Allow all Views check box selected. This is a quick and efficient way
to include all project views at once for the selected server.
9. Click Save, click OK on the confirmation dialog box, then restart the Web Server.
When changes to the configuration are saved, the changes are applied dynamically. The Web Server
process monitors the file for changes and applies all changes that are made.

Removing a StarTeam Server Configuration from the Web
Server
1.
2.
3.
4.

In the Available Servers folder tree, highlight the server configuration you want to remove.
Click Remove Selected Server.
Click Save.
Click OK on the confirmation dialog box, then restart the Web Server.

Setting Up the Web Server as a Windows Service
If running the Web Server as a Windows service, change the following parameters in the file
StarTeamService32.bat for 32-bit installations or StarTeamService64.bat for 64-bit installation first.
•
•

--JvmMx - The maximum memory provided to the Web Server. The value should be specified in MB; the
default value is 4096.
--Startup - Determines if the Windows Service will start up automatically or manually. The default value
is auto and can be changed to manual.

Prior to running StarTeamService.bat, set the CATALINA_HOME environment variable on Windows to
point to <Install Directory>.
To set up the StarTeam Web Server as a Windows Service, run <Install
Directory>/StarTeamService32.bat or <Install Directory>/StarTeamService64.bat.
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To remove the StarTeam Web Server as a Windows Service, run <Install Directory>/service.bat
remove located in the installation folder.
See http://tomcat.apache.org/tomcat-5.5-doc/windows-service-howto.html for documentation on how to setup
tomcat as a windows service.
See http://commons.apache.org/daemon/procrun.html for full documentation on the tomcat5.exe program.

setenv.bat
Syntax:
The setenv.bat is used to modify or to set environment variables for the Tomcat application server.
These setting only apply when using the catalina.bat or the startup.bat methods for starting the tomcat
application server.
Tomcat uses the following important environment variables:
Variable

Description

CATALINA_HOME

May point at your Catalina build directory.

CATALINA_BASE

(Optional) Base directory for resolving dynamic portions of
a Catalina installation. If not present, resolves to the same
directory that CATALINA_HOME points to.

CATALINA_OPTS

(Optional) Java runtime options used when the start, or
run command is executed.

CATALINA_TMPDIR

64

(Optional) Directory path location of temporary directory the
JVM should use (java.io.tmpdir). Defaults to
%CATALINA_BASE%\temp.

JAVA_HOME

Must point at your Java Development Kit installation.
Required to run the with the debug argument.

JRE_HOME

Must point at your Java Runtime installation. Defaults to
JAVA_HOME if empty.

JAVA_OPTS

(Optional) Java runtime options used when the start,
stop, or run command is executed.

JSSE_HOME

(Optional) May point at your Java Secure Sockets Extension
(JSSE) installation, whose JAR files will be added to the
system class path used to start Tomcat.

JPDA_TRANSPORT

(Optional) JPDA transport used when the jpda start
command is executed. The default is dt_shmem.

JPDA_ADDRESS

(Optional) Java runtime options used when the jpda
start command is executed. The default is dbconn.

JPDA_SUSPEND

(Optional) Java runtime options used when the jpda
start command is executed. Specifies whether JVM
should suspend execution immediately after startup. Default
is n.

JPDA_OPTS

(Optional) Java runtime options used when the jpda
start command is executed. If used, JPDA_TRANSPORT,
JPDA_ADDRESS, and JPDA_SUSPEND are ignored.Thus,
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Variable

Description
all required jpda options MUST be specified. The default is:

-Xdebug
-Xrunjdwp:transport=%JPDA_TRANSPORT%,
address=%JPDA_ADDRESS%,server=y,suspend=%JPDA_SUSPEND%
StarTeam Defaults
The following are the StarTeam Web-Server defaults:
Name

Defaults

JPDA_TRANSPORT

dt_socket

JPDA_ADDRESS

8000

JPDA_SUSPEND

y

JAVA_OPTS

-Xmx1024M
-Dcom.borland.starteam.web.configdir="%CATALINA_HOME%\shared\BorlandStarTeam"
-Djava.library.path="%CATALINA_HOME%\shared\lib"

JRE_HOME

C:\Program Files\Borland\\Java\Sun1.6.0_29

StarTeamService.bat
The StarTeamService32.bat or the StarTeamService64.bat script is installed with the StarTeam Web
Server to install the product as a service. The install script first calls the service.bat install option. This will
install the StarTeam Web Server application as a Windows service.
The StarTeamService32.bat or StarTeamService64.batscript then calls the tomcat5.exe service
utility to update the service parameters.
The default update call is:
tomcat5.exe
//US//Tomcat5 ++JvmOptions
-Dcom.borland.starteam.web.configdir="%CATALINA_HOME%\shared\BorlandStarTeam";-Djava.library.path="%CATALINA_HOME%\shared\lib"
--JvmMx 1024 --Startup auto --JavaHome "C:\Program
Files\Borland\\Java\Sun1.6.0_29"
The following are the parameters that are altered and their meaning:
Note: Parameters may be different depending on 32- or 64-bit operating systems.
•
•
•

Update service parameters for service name Tomcat5: //US//Tomcat5
Update Java Virtual Machine options: Sets a Java System Property named
'com.borland.starteam.web.configdir' used by the StarTeam Web-Server application code.
Modify the 'java.library.path' Java System Property to be the 'shared\lib' directory. This is where StarTeam
libraries are installed.
++JvmOptions
-Dcom.borland.starteam.web.configdir="%CATALINA_HOME%\shared\BorlandStarTeam";-Djava.library.path="%CATALINA_HOME%\shared\lib"

•

Update the Java Maximum Memory usage. The defaults are quite small: --JvmMx 1024
Note: For a 32-bit process model, the maximum virtual address size of the process is typically 4 GB,
though some operating systems limit this to 2 GB or 3 GB. The maximum heap size is typically
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-Xmx3800m (1600m) for 2 GB limits), though the actual limitation is application dependent. For 64-bit
process models, the maximum is essentially unlimited.
•
•

Update the Service startup mode to be 'auto'. The StarTeam Web Server will automatically start whenever
the computer starts: --Startup auto
Update a different JAVA_HOME than defined by JAVA_HOME environment variable: --JavaHome
"C:\Program Files\Borland\Java\Sun1.6.0_29"

service.bat
Apache Tomcat provides the service.bat. It is used to manually install tomcat as a service.
Administrator privileges are required to run this script.
Note: On Windows Vista or any other operating system with User Account Control (UAC) you must either
disable UAC or right-click on cmd.exe and select Run as administrator in order to run this script. If UAC
is enabled, being logged on with an Administrator account is not sufficient.
Script Option

Description

Install

Install the service using Tomcat5 as service name. Service
is installed using default settings.

Remove

Remove the service from the system.

Name

(optional) If the second argument is present it is considered
to be new service name.

Default Service Name

tomcat5

Default Display Name

Apache Tomcat

Tomcat5w.exe
Tomcat5w is a GUI application for monitoring and configuring Tomcat services.
Users double-click the %CATALINA_HOME%\bin\tomcat5w.exe executable to verify or modify service
parameters.
The available command line options are:
•
•

//ES//: Edit service configuration. This is the default operation. It is called if no option is provided, but the
executable is renamed to servicenameW.exe.
//MS//: Monitor service. Put the icon in the system try.

Tomcat5.exe
The following information is provided by Apache Tomcat.
Tomcat5.exe is a application that allows Windows users to wrap Java applications as a Windows service.
The service can be set to automatically start when the machine boots and will continue to run with no user
logged on to the machine.
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Tomcat5.exe command line arguments
Each command line directive is in the form of //XX[//ServiceName]. If the //ServiceName parameter
is omitted, then the service name is assumed to be the name of the file. For example, if the application is
renamed as TestService.exe, the default service name is TestService.
The available command line options are:
Command Option

Description

//TS

Runs the service as a console application. This is the default
operation. It is called if no option is provided.

//RS

Runs the service. It is called only from ServiceManager.

//SS

Stops the service

//US

Updates service parameters

//IS

Installs service

//DS

Deletes service and stops the service first if it is currently
running.

//PP[//seconds]

Pause. Default is 60 seconds.

//VS

Version. Print version and exit (since version 1.0.3).

//?

Help. Print usage and exit (since version 1.0.3).

Command Line Parameters
Each command parameter is prefixed with --. If an environment variable exists with the same name as command
line parameter but prefixed with PR_ it will take precedence.
If a parameter is repeated, the last value takes precedence. However, some parameters can take multiple
values, for example StartParams and JvmOption. If these parameters are prefixed with ++, the value is appended
to the existing value.
Only multi-valued parameters support the parameter ++ prefix. They are indicated in the table below by ++. If
++ is used for a parameter that does not support multiple values, then it is treated the same as --. No error is
reported.
Parameter

Description

--Description

Service name description (maximum 1024 characters)

--DisplayName

Default: ServiceName
Service display name

--Install

Default: tomcat5.exe. //RS//ServiceName.
Install image

--Startup

Default: manual
Service startup mode can be either auto or manual

--Type

Service type can be interactive to allow the service to interact
with the desktop. Use this option only with Local system
accounts.
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Parameter

Description

++DependsOn

List of services that this service depends on
Dependent services are separated using either # or ;
characters.

++Environment

List of environment variables that will be provided to the
service in the form key=value. They are separated using
either # or ; characters. If you need to embed either # or
; character within a value put them inside single quotes.

--User

User account used for running executable
It is used only for StartMode Java or exe and enables running
applications as a service under an account without the
LogonAsService privilege.

--Password

Password for user account set by --User parameter

--ServiceUser

Specifies the name of the account under which the service
should run
Use an account name in the form DomainName\UserName.
The service process will be logged on as this user. if the
account belongs to the built-in domain, you can specify
.\UserName.

--ServicePassword

Password for user account set by --ServiceUser parameter

--LibraryPath

Directory added to the search path used to locate the DLLs
for the JVM
This directory is added both in front of the PATH environment
variable and as a parameter to the SetDLLDirectory function.

--JavaHome

Default: JAVA_HOME
Set a different JAVA_HOME than defined using
JAVA_HOME environment variable.

--Jvm

Default: auto
Use either auto to find the JVM from the Windows registry
or specify the full path to the jvm.dll. You can use
environment variable expansion.

++JvmOptions

Default: -Xrs
List of options in the form of -D or -X that will be passed to
the JVM. The options are separated using either # or ;
characters. if you need to embed either # or ; character
put them inside single quotes. This is not used in exe mode.

--Classpath

Set the Java classpath. This is not used in exe mode.

--JvmMs

Initial memory pool size in MB.
This is not used in exe mode.
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Parameter

Description

--JvmMx

Maximum memory pool size in MB
This is not used in exe mode.

--JvmSs

Thread stack size in KB
This is not used in exe mode.

--StartMode

One of jvm, Java or exe
The modes are:
•

* jvm - starts Java in-process. It depends on jvm.dll,
see --Jvm.

•

* Java - This is the same as exe, but automatically
uses the default Java executable. For example.

%JAVA_HOME%\bin\java.exe. Make sure
JAVA_HOME is set correctly. Or use JavaHome to
provide the correct location. If neither is set, tomcat5
tries to find the default JDK, not the JRE, from the
Windows registry.
•

--StartImage

* exe - runs the image as a separate process.

Executable to run
This only applies to exe mode.

--StartPath

Working path for the start image executable

--StartClass

Class that contains the startup method
Applies to the jvm and Java modes. It is not used in exe
mode.

--StartMethod

Default: main
Name of method to be called when service is started. It must
be static void and have argument (String args[]). Only applies
to jvm mode - in Java mode, the main method is always
used.
Note: In jvm mode, the start method should not return
until the stop method has been called.

++StartParams

List of parameters that will be passed to either StartImage
or StartClass
Parameters are separated using either # or ; character.

--StopMode

One of jvm, Java or exe
See --StartMode for further details.

--StopImage

Executable that will be run on Stop service signal
This only applies to exe mode.
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Parameter

Description

--StopPath

Working path for the stop image executable
This does not apply to jvm mode.

--StopClass

Class that will be used on Stop service signal
Applies to the jvm and Java modes.

--StopMethod

Default: main
Name of method to be called when service is stopped
It must be static void and have argument (String args[]). This
only applies to jvm mode. In Java mode, the main method
is always used.

++StopParams

List of parameters that will be passed to either StopImage
or StopClass
Parameters are separated using either # or ; character.

--StopTimeout: Default

No Timeout
This parameter defines the timeout in seconds that tomcat5
waits for service to exit gracefully.

--LogPath: Default

%SystemRoot%\System32\LogFiles\Apache
Defines the path for logging and creates the directory if
necessary

--LogPrefix: Default

commons-daemon
Defines the service log filename prefix
The log file is created in the LogPath directory with
.YEAR-MONTH-DAY.log suffix.

--LogLevel

Default: Info
Defines the logging level and can be either Error, Info,
Warn or Debug.

--LogJniMessages

Default: 0
Set this non-zero (e.g. 1) to capture JVM jni debug
messages in the tomcat5 log file. This iss not needed if
stdout/stderr redirection is being used. This only
applies to jvm mode.

--StdOutput

Redirected stdout filename
If named, auto file is created inside LogPath with the name
service-stdout.YEAR-MONTH-DAY.log.

--StdError

Redirected stderr filename
If named, auto file is created in the LogPath directory with
the name service-stderr.YEAR-MONTH-DAY.log.
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Parameter

Description

--PidFile

Defines the file name for storing the running process id
The actual file is created in the LogPath directory.

Enabling SSL Using a Valid Certificate
You must have a valid certificate available in order to enable Secure Socket Layer (SSL).
1. Edit the <Install Directory>/apache-tomcat-5.5.27/conf/server.xml file in the follow ways.
•

Comment out the following xml block to disable the standard http access.
<Connector port="8080" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />

•

Uncomment the following xml block to enable https access and add the attributes.
<Connector port="8443" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" scheme="https" secure="true"
keystoreFile="<path to certificate>" and keystorePass="<password>"
clientAuth="false" sslProtocol="TLS" />

2. Start the Web Server and direct users to https://<hostname>:8443/BorlandStarTeam. <hostname>
is the name of the computer where the Web server is running. When typing the hostname, do not use the
angle brackets.

Changing the Session Timeout Value
The Session Timeout value is used to determine when a user's Web Client session becomes invalid due to
inactivity. When a session times out, the user must be reauthenticated in order to continue to use the session.
To change the default Session Timeout, the Administrator should perform the following steps.
1. Navigate to the file BorlandStarTeam.xml located
/apache-tomcat-5.5.27/conf/Catalina/localhost in the installation folder.
2. Change the maxInactiveInternal attribute. This value is read in seconds and defaults to 1800 seconds
(30 minutes).

Changing the Memory Allocated to the Web Server
The number of memory the Web Server can consume while running directly affects the amount of StarTeam
views that can be supported on the Web Server. To increase the memory provided to the Web Server in order
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to support larger StarTeam configurations, the Administrator should perform the following steps before starting
the Web Server.
1. Navigate to the file setenv.bat located in /apache-tomcat-5.5.27/bin in the installation folder.
2. Increase the JAVA_OPTS=-Xmxvalue. value is the maximum size, in bytes, of the memory allocation pool.
This value myst be a multiple of 1024 greater than 2MB. You can append the letter k or K to indicate
kilobytes, or m or M to indicate megabytes. For example, the value can appears as -Xmx83886080,
-Xmx81920k, or -Xmx80m.

Setting the Log Output Level
The logging level that the Web Server uses when updating the log files in the directory
/apache-tomcat-5.5.27/logs is specified in the file
/apache-tomcat-5.5.27/shared/classes/logging.properties in the installation folder. The
following levels can be set in the file.
•
•
•
•
•
•
•
•
•

OFF
SEVERE
WARNING
INFO (default)
CONFIG
FINE
FINER
FINEST
ALL

Running Apache Tomcat Native
The Web Server does not ship with the library tcnative-1.dll for running Apache Tomcat Native. Testing
of the Web Server on the supported platform did not show any benefit to running the Web Server with native
enabled. If you wish to run the Web Server with native enabled, the 64-bit library tcnative-1.dll can be
downloaded from the Apache Software Foundation Web site at http://tomcat.apache.org/. Place the file in the
installation folder /apache-tomcat-5.5.33/shared/lib, and restart the Web Server to pick up the change.
Note: When downloading the file tcnative-1.dll, please be sure to download the version of the file
that matches your 64-bit architecture (AMD64 or Intel IA64) and Internet Protocol (IPv4 or IPv6).

Specifying Item Details for the Web Client
The records in the Web Client Item Table display a subset of the item property values defined by the selected
filter. Embedded item details can be used to reveal item properties not shown in the Item Table.
The default embedded item details for each item type are as follows.
•
•
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•
•
•

CR - Synopsis, Description, Fix
File - Description
Topic - Title, Description

Administrators can also create custom html details templates and place them in the installation folder in
/apache-tomcat-5.5.27/shared/BorlandStarTeam. If a custom html details template is found for the
current type, that template will be used to render the embedded details. The html details template format
supported by the Web Client is the same format supported by the StarTeam Cross-Platform Client. Refer to
the StarTeam Cross-Platform Client Help for more information.
The following are the required names for details templates:
•
•
•
•
•

file.details.html
changerequest.details.html
requirement.details.html
task.details.html
topic.details.html

Creating a Custom Details Template
This section contains a sample of the details template that you can make for any item type viewed from the
Web Client. This example is for Change Requests.
To create a details template for the Change Request component:
1. Create the file changerequest.details.html in the installation folder in
\apache-tomcat-5.5.27\shared\BorlandStarTeam\.
2. Edit the file in a text editor.
3. Type the following code content:
<table>
<tr>
<td align=left valign=top><b>CR ~~ChangeNumber~~ (~~DotNotation~~):
~~Synopsis~~</b></td>
</tr>
</table>
<br>
<table border=1>
<tr>
<td width=200 align=center><b>Timestamps</b></td>
<td width=200 align=center><b>Entered</b></td>
<td width=200 align=center><b>Resolved</b></td>
<td width=200 align=center><b>LastModified</b></td>
<td width=200 align=center><b>Closed</b></td>
<td width=200 align=center><b>Verified</b></td>
</tr>
<tr>
<td width=200 align=right><b>By:</b></td>
<td width=200 align=left>~~EnteredBy~~</td>
<td width=200 align=left>~~AddressedBy~~</td>
<td width=200 align=left>~~ModifiedUserID~~</td>
<td width=200 align=left>&nbsp;</td>
<td width=200 align=left>&nbsp;</td>
</tr>
<tr>
<td width=200 align=right><b>Time:</b></td>
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<td width=200
<td width=200
<td width=200
<td width=200
<td width=200
</tr>
</table>
4.
5.
6.
7.

align=left>~~CreatedTime~~</td>
align=left>~~ResolvedOn~~</td>
align=left>~~ModifiedTime~~</td>
align=left>~~ClosedOn~~</td>
align=left>~~VerifiedOn~~</td>

Save the custom details template file.
Restart StarTeam Web Server.
View the items table for Change Requests.
Expand the details of the Change Request to view the custom details.

Accessing the StarTeam Web Client
To access the StarTeam Web Client, open a supported browser and enter the following URL in the address
bar: http://<hostname>:<port>/BorlandStarTeam/BorlandStarTeam.jsp. <hostname> is the
name of the computer where the Web Server is running and <port> is the TCP/IP port number used by the
Web server. When typing the hostname and port, do not use the angle brackets.
The Web Client Start page opens.
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Installing Layout Designer
This chapter explains how to install the Layout Designer. To learn to how use the Layout Designer, refer to
the online help or Start ➤ Borland StarTeam ➤ StarTeam Layout Designer ➤ Documentation sub-menu.
The Layout Designer provides the ability to customize forms within the application. Custom property-editor
forms can be used for any item-type to show custom properties, hide default properties that are not of interest
to your organization, or rearrange the interface to more closely meet your organization’s requirements.
For example, you can design a Change Request Properties dialog box that has custom fields on its first (or
perhaps only) tab. You usually install Layout Designer on the workstations of administrators who will design
custom property editors.
Only in the Web Client, Property editors designed with Layout Designer can be used with the custom workflow
rules created with Workflow Designer (for StarTeam Enterprise Advantage). In the Cross-Platform Client,
Layout Designer forms only arrange properties for the user's convenience. APEs are written to support the
workflow rules. For more information about APEs, see the Workflow Extensions Guide that installs with Workflow
Designer.

System Requirements for the Layout Designer
The Layout Designer can be installed on Microsoft Windows systems that support Sun Microsystems Java
Virtual Machine 1.6.0_13. The system requirements are listed below:
System Area

Requirement

Platforms (32-bit)

Windows XP Professional SP3
Windows Vista SP1
Red Hat Enterprise Linux Desktop (WS) 5.1

Processor

32-bit dual core

RAM

2 GB minimum

Hard disk space

200 MB to install the application
Note: Sufficient disk space is required for your working
files. The amount will vary depending on your use of
the product.

Display

SVGA, high color mode, 1024x768
Recommended resolution: 1280x1024 or more
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Installing Layout Designer
To install Layout Designer on Linux, extract the downloaded tar.gz file. To install the Layout Designer on
Windows follow the steps below.
Note: Before you install Layout Designer, verify that the StarFlow Extensions project exists on the server
on which the form will be developed and used.
1. On the computer where you wish to install the Layout Designer, log on as the administrator or as a user
with administrative privileges.
2. Run the downloaded installer.
3. Select a language from the drop-down list, and click OK.
4. Select a language from the drop-down list, and then click OK.
5. In the Introduction dialog box, read the information, and then click Next.
6. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c) Click Next.
7. Choose an installation folder. The default installation path is C:\Program Files\Borland\StarTeam
Layout Designer.
8. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeam Layout Designer).
9. In the Pre-installation Summary dialog box, review the settings. If you want to make changes, click
Previous one or more times so that you can change the installation options. Then return to the
Pre-installation Summary dialog box and click Install.
10. In the Install Complete dialog box, click Done.
The Layout Designer is installed in the specified folder.
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Installing Workflow Extensions
This chapter explains how to install the following Borland StarTeam Workflow Extensions components:
•
•
•

Extensions
Workflow Designer
Notification Agent

These components are for StarTeam Enterprise Advantage only. See the Workflow Extensions Guide for
complete information about how to configure and use these Workflow Extensions.
Note: This product is only available in English.

About Workflow Extensions
Workflow is a comprehensive term to explain a process by which members of an organization complete complex
tasks. Whether your organization uses formalized or ad hoc workflows, there is a process or pattern by which
work is accomplished. Borland StarTeam Workflow Extensions automates workflows by providing automatic
notification of responsibility, by presenting only appropriate options at each step in the process, and by assuring
that items are acted upon in a timely manner.
The products, tools, and features Workflow Extensions provides to set up and maintain workflow processes
are described in the following sections.

About Extensions
Borland StarTeam Extensions includes:
•
•
•
•

Alternate Property Editors (APEs), forms written in Java, replace the standard properties dialog boxes that
come with each component of the application.
A workflow engine that reads the appropriate .Workflow.xml file and populates the APEs.
A toolbar that can be used with the Cross-Platform Client to start applications that add new features to the
application.
Various other utilities and libraries written in Java.

About Workflow Designer
Borland StarTeam Workflow Designer outputs .xml files that formalize the steps in a workflow, specifies who
will be notified about each step and about exceptions, and so on. Each file is named item_type.Workflow.xml
and can be used for an entire project or individual views within that project. item_type is the type of StarTeam
item such as ChangeRequests or Requirement. The Extensions workflow engine and Notification Agent read
from these files.
You must use Workflow Designer to develop custom workflows. The resulting .Workflow.xml file can be
deployed in StarTeam installations as long as the most recent version of Extensions is also installed.
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About Notification Agent
Notification Agent monitors server configurations to determine who needs to be notified about work to be
performed and about exceptions that occur in the workflow process.
When changing the enumerated values for fields used to control notification (for example, when updating the
workflow for a project or view), restart Notification Agent so that it updates its cache.

System Requirements for Workflow Extensions
Extensions and Workflow Designer have the same system requirements as the Cross-Platform Client. For
more information, see System Requirements for the Cross-Platform Client on page 54.
Notification Agent has the same system requirements as Server. For more information, see System
Requirements for the Server on page 18.
It is good practice to install the Borland StarTeam Server prior to installing Notification Agent.

Extensions Installation Strategies
Files from StarTeam Extensions need to be installed and then checked in to the StarFlow Extensions project
in each server configuration that uses alternate property editors (APEs) and workflows. If the StarTeam server
configuration does not already have a StarFlow Extensions project, you need to add one and all users need
to have read access to the files in it. Administrators can have read/write access.
The default installation folder is C:\Program Files\Borland\StarFlow Extensions, but Micro Focus
recommends copying the runtime files to a different folder for each server configuration. For example, you
might use C:\config_name\StarFlow Extensions. In this way, you can ensure that each configuration’s
StarFlow Extensions project has different working folders.
Even if you currently run only one server configuration, it is wise to plan ahead. This also ensures that, when
you upgrade or reinstall for some other reason, you are unlikely to overwrite any StarTeam Extensions files
that you are using.
Caution: If you are using the default installation folder for any server configuration’s StarFlow Extensions
project, Micro Focus recommends that you check in everything you need that is not current prior to
reinstalling or upgrading StarTeam Extension files.

Installing Extensions
To install Extensions on Windows:
1. Run the downloaded installer.
To install Extensions on Linux or systems that support Java, extract Extensions-2009-LINUX.tar.gzor
Extensions-2009-UNIUX.tar.gz.
2. In the Introduction dialog box, read the information, and click Next.
3. In the License Agreement dialog box:
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a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
4. In the Choose Install Folder dialog box, click Choose… to browse to the desired location for the installation
folder.
The default Installation location is C:\Program Files\Borland\StarFlow Extensions.The following
options are provided.
•
•

To change the default location, click Choose...
To restore the default location, click Restore Default Folder.

5. Click Next to continue.
6. In the Choose Install Set dialog box, choose your preferred options:
•

Runtime - Installs the files that are critical to each server configuration that uses workflow, APE forms,
and/or custom tools. The Runtime should be installed on the same computer as the Server.
The Runtime consists of the StarFlow Extensions folder and two subfolders:
•

The Client folder contains the files that are normally installed with one or more of the clients as well
as with StarTeam Extensions. If a user is having problems with an APE, give that user the latest files
from the Client folder in the StarFlow Extensions project. It may solve the problem.
starteam-extensions.jar provides the Locator functionality (the retrieving of workflow and APE files)
in conjunction with Locator.exe. The starteamextensions. jar file is installed with both the
Cross-Platform Client and the Visual Studio integration. The Locator files are installed only with the
Visual Studio integration.

•

The Projects folder contains a variety of .jar, .xml, and .dll files used by StarTeam Extensions.

Although the Runtime includes a custom toolbar that can be used with the Cross-Platform Client, if you
will be writing applications for the toolbar or adding buttons to the toolbar, you should seek assistance
from Micro Focus consultants.
•

Samples - Adds the Samples subfolder to the StarFlow Extensions folder.
The Samples can be installed on any computer for your convenience. You do not need to copy these
to each server configuration’s StarFlow Extensions folder, nor do you need to check them in.
If you decide to use some of the sample APE forms, as they are or after some modification, you would
copy the item_type.Workflow.xml, name.propertyeditor.xml, and name.jar files to a server
configuration’s StarFlow Extensions\Projects folder or an appropriate subfolder of the Projects
folder. Then you would check these files in to the StarFlow Extensions project. item_type is a type of
StarTeam item such as ChangeRequest or Requirement.
If you decide to use some of the sample tools, as they are or after some modification, you must also
copy the name.tool.xml and the name.jar files to the Projects folder. See the Workflow Extensions Guide
for more information.

•

API Documentation - Adds the Documentation subfolder to the installation folder.
The Documentation can be installed on any computer for your convenience. You do not need to copy
this folder to each server configuration’s StarFlow Extensions folder, nor do you need to check its files
in. These online documents (.html files) explain the APIs for the APEs and the custom toolbar.

7. Click Next.
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8. In the Choose Shortcut Folder dialog box, use the default settings. Keep the Other option button set to
C:\Documents and Settings\All Users\Start Menu\Programs\Borland StarTeam\StarTeam
Extensions.
9. Click Next.
10. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box and
click Install.
11. In the Install Complete dialog box, click Done.
After installing Extensions Runtime:
•
•
•

Copy the StarFlow Extensions folder and its subfolders (Client, Projects, and Utilities) to a unique location
for each server configuration.
Use the StarFlow Extensions folder (in its new location) as the root folder for the StarFlow Extensions
project that you create for each server configuration.
Add the files in these folders to the StarFlow Extensions project—except for PDFs and readmes.
If you are already using StarTeam Extensions, check in these files as new revisions of existing files and
add any new files.

Installing Workflow Designer
You must use Workflow Designer to develop custom workflows. Workflow Designer outputs .xml files that
formalize the steps in a workflow, specifies who will be notified about each step and about exceptions, and so
on. Each file is named item_type.Workflow.xml and can be used for an entire project or individual views
within that project. item_type is a type of StarTeam item such as Change Request or Requirement. The
StarTeam Extensions workflow engine and Notification Agent read from these files.
Workflow Designer can be installed separately on any workstation.
To install Workflow Designer on Windows:
1. Run the downloaded installer.
To install on Linux, extract WorkflowDesigner-2009-LINUX.tar.gz.
2. In the Introduction dialog box, read the information, and click Next.
3. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c) Click Next.
4. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the installation
folder. The default is C:\Program Files\Borland\StarTeam Workflow Designer.
5. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button set
to C:\Documents and Settings\All Users\Start Menu\ Programs\Borland StarTeam\StarTeam Workflow
Designer).
6. In the Pre-installation Summary dialog box, do one of the following:
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•
•

Review the settings and click Install.
Review the settings and click Previous one or more times if you want to change the installation options.
Then return to the Pre-installation Summary dialog box and click Install.

7. When you see the Install Complete screen, read the message to be sure that the installation was successful,
then click Done.

Installing Notification Agent
Notification Agent monitors server configurations to determine who needs to be notified about work to be
performed and about exceptions that occur in the workflow process.
You must install and configure Notification Agent separately. It is usually installed on the computer that runs
the StarTeam Server, but can be installed anywhere. When Notification Agent is not on the same computer
as the Server, the two computers clocks must be synchronized. Notification Agent’s time cannot be ahead of
the Server’s time. When both are installed on the same computer and run as services, Notification Agent must
be run as a dependent service and be shut down first. See “Running Notification Agent as a Service” in the
StarTeam Workflow Extensions User’s Guide for more information.
To install the Notification Agent on Windows:
1. Run the downloaded installer.
2. In the Introduction dialog box, read the information, and click Next.
3. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c) Click Next.
4. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the installation
folder. The default is C:\Program Files\Borland\StarTeam Notification Agent.
5. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\ Programs\Borland StarTeam\StarTeam Notification
Agent).
6. In the Pre-installation Summary dialog box, do one of the following:
•
•

Review the settings and click Install.
Review the settings and click Previous one or more times if you want to change the installation options.
Then return to the Pre-installation Summary dialog box and click Install.

7. When you see the Install Complete screen, read the message to be sure that the installation was successful,
then click Done.
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Using StarTeam with Microsoft SQL Server
and SQL Server Express Databases
This chapter explains how to create a new server configuration to use Microsoft SQL Server or SQL Server
Express database with StarTeam Server. StarTeam Server stores everything except for file archives and server
startup information in the database of your choice.
You can use the Windows version of StarTeam Server with the supported Microsoft databases listed in
Supported Databases on page 19.
Microsoft SQL Server 2005 Express (SSE 2005) is the StarTeam default database. We advise users to read
the SQL Server Express license agreement provided by Microsoft Corporation.
StarTeam Server completely automates the process of creating SQL Server and SQL Server Express databases
for use with StarTeam server configurations. However, if you prefer, you can create your own database. See
Creating a Database Manually: Overview on page 91 for more information.
This chapter also provides an overview of the tuning and maintenance SQL scripts that are provided with
StarTeam Server and explains how to use them. For detailed information on Microsoft SQL Server performance
tuning, consult your Microsoft SQL Server documentation.

Terminology for Microsoft Databases
When this chapter uses the terms "instance" and "database", it uses Microsoft terminology. When you install
Microsoft SQL Server on a computer, you can install up to 16 instances of it. Each instance can manage a
number of different databases. Each StarTeam Server configuration uses its own database. When you perform
a typical installation of the StarTeam Server, you install one instance of SQL Server Express.

Logging Onto Databases
It is highly recommended that you use a dedicated StarTeam user account to run or log onto the databases
used with StarTeam Server configurations. System administrator accounts usually have unlimited privileges.
Any anomalies or errors that occur while you are logged in as the system administrator may result in
unrecoverable damage to StarTeam databases and other databases managed by the same database server.

Understanding the Encoding Differences
StarTeam Server sends data encoded as UTF-8. Microsoft SQL Server and SQL Server Express do not support
UTF-8 at the database level. They support nchar, nvarchar, and ntext to store fixed format Unicode data
(UTF-16).
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•
•

UTF-8 is a variable length character set in which the characters can expand from one to six bytes depending
on the language.
UTF-16 is a fixed length encoding mechanism in which every character expands to two bytes. UTF-16
tends to use up more space than UTF-8 when applied to character sets in which one character always
translates to one byte.

Because of the way StarTeam encodes data, non-English StarTeam data is human-readable from StarTeam
clients, but not from Microsoft SQL Server and SQL Server Express.

Creating a Server Configuration (for an Existing Database)
The first time you start a new server configuration, StarTeam Server creates all StarTeam tables in the database
you specify. This section explains how to create a StarTeam server configuration using a previously created
Microsoft SQL Server or SQL Server Express database.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

To create a server configuration using an existing Microsoft SQL Server or SQL Server Express database:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
a) Type the name of the configuration in the Configuration Name text box.
If you want the server configuration to have the same name as the database (a nice convention, especially
if you have several server configurations), you must follow the naming conventions for Microsoft SQL
Server and SQL Server Express databases explained at the beginning of this section.
b) Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
c) Select Microsoft SQL Server/SSE (the default) from the Database Type drop-down list box.
d) Uncheck the option to Create new StarTeam database, so that that StarTeam will not automatically
create the database for it.
e) Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.

Using StarTeam with Microsoft SQL Server and SQL Server Express Databases

| 83

•
•
•

Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

f) Click Next, and enter the Database Server name, Database name, Database login name, and password
in the appropriate text boxes.
g) Optionally, if you are using a port other than the default, check Edit Database Port and type the port
number in the text field.
h) If you are not sure of the values supplied, click Verify Connection to test the connection.
i) Click Finish.
This action re-displays the Server Administration tool, which shows your new server configuration as a
child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about this
file, see the StarTeam Server Help guide.
4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint. To change the endpoint:
a) Select the server configuration.
b) Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
c) Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
5. Be sure to configure your new server configuration (for information, see the StarTeam Server Help) and
plan a backup schedule for it.

Overview of Using a Microsoft SQL Server Database
If you will be using a Microsoft SQL Server database, you must complete the following tasks:
1. Install Microsoft SQL Server.
Important: When you install a Microsoft SQL Server database instance, it defaults to the collation for
the locale set for the operating system. This locale setting should be used so long as it is correct for
your team. Otherwise, when you automatically create a database from StarTeam Server, you cannot
provide a database name, user name, or password in your language.
2. Install StarTeam Server. For more information, see Installing theBorland StarTeam Server on page 27.
3. Create and start a StarTeam server configuration.
•
•

If you want StarTeam to automatically create the database, see Creating and Starting a Server
Configuration on page 85.
Otherwise, see Creating a Database Manually: Overview on page 91.

If you plan to use a supported version of Microsoft SQL Server, see Connecting to Microsoft SQL Server
Databases on page 85 for more information.
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Caution: After you have started using StarTeam with Microsoft SQL Server:
•
•

Never modify the database contents other than through a StarTeam client or Server Administration
tool. Direct database manipulation is unsupported.
Never modify vault files other than through a StarTeam client or a Server Administration tool.

Connecting to Microsoft SQL Server Databases
StarTeam Server requires Microsoft SQL Server authentication to connect to Microsoft SQL Server databases,
rather than the default Windows authentication. If you install Microsoft SQL Server using the default settings
for security and authentication, StarTeam Server will experience problems connecting to the database.
To specify the security to use when connecting to Microsoft SQL Server:
1. Start the Microsoft SQL Server Installation Wizard.
2. Go to the Authentication Mode page of the wizard.
3. Select Mixed Mode (Windows Authentication and SQL Server And Windows option button (instead of the
Windows Only option).
4. Type and retype the password to use.
5. Click Next to complete the rest of the wizard.

Creating and Starting a Server Configuration
The first time you start a new server configuration, StarTeam Server creates all of the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time. It assumes that you want StarTeam Server to automatically create a Microsoft SQL Server or SQL
Server Express database. If that is not the case, see Creating a Database Manually: Overview on page 91.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain ASCII letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

The Server Administration database options may fail to run for databases with names that do not follow these
guidelines.
To create a server configuration using a Microsoft SQL Server or SQL Server Express database:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
a) Type the name of the configuration in the Configuration Name text box. If you want the server
configuration to have the same name as the database (a nice convention, especially if you have several
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b)

c)
d)
e)

server configurations), you must follow the naming conventions for Microsoft SQL Server and SQL
Server Express databases explained at the beginning of this section.
Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
Select Microsoft SQL Server/SSE (the default) from the Database Type drop-down list box.
Check the option to Create new StarTeam database, so that StarTeam Server automatically creates
the database.
Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

f) Click Next to create the SQL/SSE database.
4. Enter the server and database information:
a) Do one of the following:
•

•
•

If you are creating a server configuration on SSE, the Database Server name text box defaults to
(local)\SSE2005_ST because the SSE instance on the computer on which StarTeam Server is
installed was given the name SSE2005_ST. Proceed to step b.
If you are creating a server configuration on Microsoft SQL Server, type or click Browse to specify
the names of the computer and the database on your network that should be used.
If you are not using the default database port, check the Edit Database Port checkbox and type the
port number in the text box.

b) Enter the password for the system administrator in the Sys Admin (sa) Password text box. If this is an
SSE instance, the initial default system administrator password is StarTeam123.
c) Click Verify Connection to test the connection. If the test connection fails, review and change your
settings.
d) In the StarTeam Schema Information text box, type the name of the data source that you want to
create, the new database name, and the new user name for the configuration. This user is the owner
of the database.
e) Type the database password for the new database in the New Database Password and Confirm
Database Password text boxes.
f) Click Next.
5. Enter the information for creating the data files and transaction logs, and click Finish.
Note: Micro Focus recommends keeping the data files and transaction log files on different physical
drives under their own disk controllers.
The default settings are appropriate for your use if you have fewer than 15 users and expect to store 1GB
or less data.
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If you are very familiar with Microsoft SQL Server and SQL Server Express databases, you may choose
to make some changes by first clearing the Use Default Configuration check box and then altering sizes
and locations for data files and log files.
Use at least 3 data files and at least 3 transaction log files when creating a database, because Microsoft
SQL Server and SQL Server Express databases use a proportional fill strategy. This way all the files tend
to become full at about the same time.
To avoid fragmentation, make the data files as large as possible, based on the maximum amount of data
expected in the database.
For more information, see Guidelines for Data Files and Transaction Logs on page 87.
The Server Administration tool displays your new server configuration as a child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about this file,
see the StarTeam Server Help guide.
6. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint. To change the endpoint:
a) Select the server configuration.
b) Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
c) Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
7. Be sure to configure your new server configuration (see the StarTeam Server Help guide for more information)
and plan a backup schedule for it.

Guidelines for Data Files and Transaction Logs
Based on the number of users, Micro Focus suggests the following guidelines for data files and transaction
logs. Your needs may be different from those shown in the following table.
1

Number of Users

Number of Data Files Size of Each Data File Number of Log Files Size of Each Log File

Up to 15

3

50 MB

3

50 MB

Between 15 and 50

3

300 MB

3

300 MB

Between 51 and 100

5

300 MB

5

300 MB

Between 101 and 300 7

500 MB

5

500 MB

>300

800 MB

6

500 MB

7

1

The transaction log file sizes are relevant only if the Transaction log backup is performed frequently.

Transaction log backups are essential. After a transaction is backed up, Microsoft SQL Server and SQL Server
Express databases automatically truncate the inactive portion of the transaction log. This inactive portion
contains completed transactions and is no longer used during the recovery process. The basic advantage
comes with the fact that Microsoft SQL Server reuses this truncated, inactive space in the transaction log
instead of allowing the transaction log to continue to grow and use more space. This is a huge plus from a
performance standpoint.
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Allowing files to grow automatically can cause fragmentation of those files if a large number of files share the
same disk. Therefore, it is recommended that files or file groups be created on as many different available
local physical disks as possible. Place objects that compete heavily for space in different file groups.

Running SQL Scripts for Microsoft Databases
StarTeam Server comes with some SQL scripts written specifically for use with the Microsoft SQL Server and
SQL Server Express databases. These scripts help you maintain and tune StarTeam databases. You run
some SQL scripts after installation, some on a weekly basis for database performance maintenance, and some
scripts are run for you automatically by StarTeam Server.
The SQL scripts for Microsoft SQL Server and SQL Server Express databases that you may run are located
in the Borland\StarTeam Server <version>\DBScripts\ Sqlserver_Scripts folder.
Note: The Sqlserver_Scripts folder contains several subfolders: Create_Stored_Procedures,
Drop_Stored_Procedures, Install, Preinstall, Generic, and DW (for Data Warehouse). The
scripts in these subfolders are run by StarTeam Server as needed. Never execute any of them directly
from an external database user interface, such as SQL Query Editor.
The following table lists the SQL scripts that you are most likely to need. Some should be run manually on a
regular basis. The table recommends the frequency for running these scripts. You may adjust the frequency
depending on the StarTeam usage at your facility. Run scripts at times when the server is least used, such as
overnight or on weekends.
In addition to running these scripts, you should also run a Purge option from the Server Administration tool to
remove deleted views from the database. Micro Focus recommends purging the database after you have
deleted one or more views from a StarTeam project. See the StarTeam Server Help guide for information on
the Purge option.
StarTeam Script Name

Run Frequency

starteam_sqlserver_dbcc.sql

Weekly

starteam_sqlserver_dbcc_reindex.sql

Twice a week (minimum)

starteam_sqlserver_dbcc_showcontig.sql

Twice a week (minimum)

starteam_sqlserver_dropall.sql

Only if necessary

Caution:
•

•

Before running any of the StarTeam SQL scripts for a Microsoft SQL Server or SQL Server Express
database, ensure that the database compatibility mode is set correctly. For Microsoft SQL Server
2005-based configurations, set the database compatibility mode to 90.
Be sure to backup your StarTeam database, as necessary, and verify these backups periodically. You
should restore and test backups of your StarTeam project data on a test system. Restoring and testing
your backups helps to ensure that your data is being backed up correctly.

To run a script for a Microsoft SQL Server or SQL Server Express database:
1. Install SQL Server Management Studio or SQL Server Management Studio Express from Microsoft.
2. Choose Start ➤ Microsoft SQL Server [or Microsoft SQL Server Express] ➤ SQL Server Manager
Studio [or SQL Server Manager Studio Express].
3. Design a new query or open an existing one in SQL Server Manager Studio.
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4. Choose Query ➤ Connection ➤ Connect to connect to the server that contains the StarTeam database
you want to access.
5. Select the appropriate StarTeam database.
6. Open the tuning script, by choosing File ➤ Open ➤ foldername\scriptname.
7. Execute the script, by clicking the Execute button on the toolbar or by pressing F5.

SQL Scripts for Microsoft SQL Server and SSE Databases
•

starteam_sqlserver_create_check_database.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_sqlserver_create_database.sql
Run: automatically by StarTeam Server when creating a new server configuration.
This script creates a new Microsoft SQL Server database.

•

starteam_sqlserver_create_upgrade_34.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_create_upgrade_36.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_create_upgrade_55.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_create_upgrade_58.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_dbcc.sql
Run: weekly.
The starteam_sqlserver_dbcc.sql script rebuilds the database indexes and performs a consistency check
on the database objects.This script builds the indexes and updates the statistics in the database distribution
pages.

•

starteam_sqlserver_dbcc_reindex.sql
Run: at least twice a week.
This script rebuilds all the indexes in the database. It is extremely important to run this script routinely.

•

starteam_sqlserver_dbcc_showcontig.sql
Run: at least twice a week.
This script gives information on database fragmentation.

•

starteam_sqlserver_dropall.sql
Run: only if necessary.
Caution: Running the starteam_sqlserver_dropall.sql script will delete all StarTeam tables and the
data they contain from the database. Use this script with extreme caution.
The starteam_sqlserver_dropall.sql script removes all StarTeam tables from the database. For example,
if you migrate a StarTeam server configuration to another database, you might use

Using StarTeam with Microsoft SQL Server and SQL Server Express Databases

| 89

starteam_sqlserver_dropall.sql to remove tables from the original database. Or if you mistakenly add the
StarTeam tables to a tablespace other than the StarTeam tablespace, use this script to remove them.
•

starteam_sqlserver_get_dbinfo.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_sqlserver_get_dbpath.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_sqlserver_run_msde_backup.sql
Run: after you customize this sample script for your specific environment. You can run this script when
needed.
This sample script illustrates how to make a backup copy of a SQL Server Express database. Before you
can run this script, you must customize it for your specific environment. (Be sure to lock or shut down
StarTeam Server before backing up its database.)

•

starteam_sqlserver_update_statistics.sql
Run: only if necessary.
This script updates the statistics about the distribution of key values in each index, which SQL Server uses
to optimize query processing. You do not need to run this script if you have enabled automatic statistics
(using sp_autostats), or if you are regularly rebuilding the indexes (by running the
starteam_sqlserver_dbcc.sql or the starteam_sqlserver_dbcc_reindex.sql scripts).

Microsoft SQL Server Security
SQL Server uses a standard security model that involves the following entities and concepts:
•
•
•

Securable - Represents a resource or target object that requires securing, such as a database view.
Principal - Represents a user who requests access to a resource.
Permission - Access type that is associated with a securable. Permissions can be granted to or revoked
from principals. For example, Update is a permission that is associated with a table (securable) named R
. If Update on R is granted to a user (principal) named U , then U receives Update access on R.

Further, SQL Server supports the following security principals at different levels:
•
•
•

Windows-level principals - Control access to SQL Server instances for Windows Local Login and Windows
Network Domain Login.
SQL Server-level principals - Control access to SQL Server instances for SQL Server Login.
Database-level principals - Control access to database instances for database users.

To access a SQL Server instance, use a Windows user name or a SQL Server user name that was previously
created in that server instance. After you log on, the user name represents you as your security principal at
the server level.
If you try to use a specific database in the server, SQL Server searches the appropriate database for any
previous user who has been mapped to your user name. If SQL Server locates such a user, the corresponding
user name represents you as your security principal at the server level.
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Creating a Database Manually: Overview
Despite the fact that StarTeam Server has automated Microsoft SQL Server and SQL Server Express database
creation, you may prefer to create your own. This makes more sense for Microsoft SQL Server because there
are good tools for database creation.
It is very important that you use the directions in the following procedure.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

The Server Administration database options may fail to run for databases with names that do not follow these
guidelines.
To create your own Microsoft SQL Server or SQL Server Express database:
1. Install Microsoft SQL Server or SQL Server Express.
Note: If you plan to use a supported version of Microsoft SQL Server, be sure to review the section
Connecting to Microsoft SQL Server Databases on page 85.
2. Install StarTeam Server. See Installing theBorland StarTeam Server on page 27 for more information.
3. Create a StarTeam database. Contact your database administrator about the specifics.
Be sure that:
•
•
•
•
•

The database is owned by a StarTeam user.
The default database for the StarTeam user is the StarTeam database.
The database will fit the expected growth patterns for storing your StarTeam data. See Guidelines for
Data Files and Transaction Logs on page 87 for more information.
The name of the database follows the conventions explained earlier in this section.
To create or upgrade the StarTeam database, the SQL Server instance must have one of the following
collations.
•
•

Latin1_General_CI_AI
SQL_Latin1_General_CP1_CI_AS

On a Japanese double-byte operating system, where the default collation for the SQL Server installation
is not supported by StarTeam, you must use a named instance with one of the supported collations.
Note:
Microsoft SQL Server's multi-instance feature supports the use of multiple instances in different
locales on the same database server.
4. Create and start a StarTeam server configuration. See Creating a Server Configuration (for an Existing
Database) on page 92 for instructions.
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Creating a Server Configuration (for an Existing Database)
The first time you start a new server configuration, StarTeam Server creates all StarTeam tables in the database
you specify. This section explains how to create a StarTeam server configuration using a previously created
Microsoft SQL Server or SQL Server Express database.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

To create a server configuration using an existing Microsoft SQL Server or SQL Server Express database:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
a) Type the name of the configuration in the Configuration Name text box.
If you want the server configuration to have the same name as the database (a nice convention, especially
if you have several server configurations), you must follow the naming conventions for Microsoft SQL
Server and SQL Server Express databases explained at the beginning of this section.
b) Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
c) Select Microsoft SQL Server/SSE (the default) from the Database Type drop-down list box.
d) Uncheck the option to Create new StarTeam database, so that that StarTeam will not automatically
create the database for it.
e) Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

f) Click Next, and enter the Database Server name, Database name, Database login name, and password
in the appropriate text boxes.
g) Optionally, if you are using a port other than the default, check Edit Database Port and type the port
number in the text field.
h) If you are not sure of the values supplied, click Verify Connection to test the connection.
i) Click Finish.

92

| Using StarTeam with Microsoft SQL Server and SQL Server Express Databases

This action re-displays the Server Administration tool, which shows your new server configuration as a
child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about this
file, see the StarTeam Server Help guide.
4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint. To change the endpoint:
a) Select the server configuration.
b) Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
c) Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
5. Be sure to configure your new server configuration (for information, see the StarTeam Server Help) and
plan a backup schedule for it.

Understanding Collation
The physical storage of character strings in the supported versions of Microsoft SQL Server and Microsoft
SQL Server Express databases is controlled by collations. A collation specifies the bit patterns that represent
each character and the rules by which characters are sorted and compared.
Microsoft SQL Server supports objects that have different collations being stored in a single database. Separate
Microsoft SQL Server collations can be specified down to the level of columns. Each column in a table can be
assigned different collations.
In a computer, characters are represented by different patterns of bits being either ON or OFF. A program that
uses one byte (eight bits) to store each character can represent up to 256 different characters. A program that
uses two bytes (16 bits) can represent up to 65,536 characters.
Single-byte code pages are definitions of the characters mapped to each of the 256 bit patterns possible in a
byte. Code pages define bit patterns for uppercase and lowercase characters, digits, symbols, and special
characters such as !, @, #, or %. Each European language, such as German or Spanish, has its own single-byte
code page. Although the bit patterns used to represent the Latin alphabet characters A through Z are the same
for all the code pages, the bit patterns used to represent accented characters (such as é and á) vary from one
code page to the next. If data is exchanged between computers running different code pages, all character
data must be converted from the code page of the sending computer to the code page of the receiving computer.
If the source data has extended characters that are not defined in the code page of the receiving computer,
data is lost. When a database serves clients from many different countries, it is difficult to pick a code page
for the database that contains all the extended characters required by all the client computers. Also, a lot of
processing time is spent doing the constant conversions from one code page to another.
Single-byte character sets are also inadequate to store all the characters used by many languages. For example,
some Asian languages have thousands of characters, so they must use two bytes per character. Double-byte
character sets have been defined for these languages. Still, each of these languages have their own code
page, and there are difficulties in transferring data from a computer running one double-byte code page to a
computer running another.
For information about synchronizing collation settings with another Windows locale, see the following Microsoft
site:
http://msdn2.microsoft.com/en-us/library/aa176553.aspx
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How Is the Default Collation Selected?
SQL Server Setup chooses the Windows collation that supports the Windows locale of the computer on which
the instance of Microsoft SQL Server is being installed. If the computer is using the US English locale, the
instance’s default collation is Latin1_General_CI_AS.
Important: On a Japanese double-byte operating system, where the default collation for the SQL Server
installation is not supported by StarTeam, you must use a named instance with one of the following
supported collations.
•
•

Latin1_General_CI_AI
SQL_Latin1_General_CP1_CI_AS

The multi-instance feature of supported Microsoft SQL Server versions supports the use of multiple
instances in different locales on the same database server.
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Using StarTeam with Oracle Databases
This chapter explains how to create a new server configuration and Oracle schema user for use with StarTeam
Server. StarTeam Server stores everything except for file archives and server startup information in the schema
user.
This chapter also provides an overview of the tuning and maintenance SQL scripts that are provided with
StarTeam Server and explains how to use them.
When you create a server configuration, StarTeam Server can automatically create the tablespace and schema
user. However, if you prefer, you can create the tablespace and schema user manually.
Note:
All of the tablespaces created using StarTeam Server automatically create locally-managed tablespaces.
All tablespaces created by StarTeam Server use AUTOALLOCATE.
StarTeam supports Oracle Universal Installer for client. Consult with your database administrator for more
information.

Terminology for Oracle Databases
When this chapter uses the terms "database instance" and "schema user", it uses Oracle terminology. Each
database instance can manage a number of different schema users. Each StarTeam server configuration
(such as the StarDraw sample) has its own schema user.
Elsewhere in the StarTeam manuals, you will find the terminology common to the other databases that StarTeam
supports. For example, when you install Microsoft SQL Server on a computer, you can run several instances
of it. Each instance can manage a number of different databases. Therefore, when you see the term “database”
in other parts of these manuals, think “schema user”.

Logging Onto Schema Users
It is highly recommended that you use a dedicated StarTeam user account to run or log onto StarTeam schema
users. System administrator accounts usually have unlimited privileges. Any anomalies or errors that occur
while logged in as the system administrator may result in unrecoverable damage to the StarTeam schema
users and other schema users managed by the same database.

Overview of Using an Oracle Schema User
If you will be using an Oracle schema user, you must complete the following tasks:
1. Install Oracle Server. Most customers install StarTeam Server and Oracle Server on separate computers.
2. Install Oracle Client on the computer on which you plan to install StarTeam Server.
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3. Establish connectivity between Oracle Client and Oracle Server. See Verifying Connectivity Between Client
and Server on page 96.
4. Install Oracle Enterprise Manager.
5. Install StarTeam Server. For more information, see Installing theBorland StarTeam Server on page 27
6. Make sure that the NLS_LANG setting for Oracle Client and the character set specified for Oracle Server
are correct. For more information, see Using NLS_LANG Correctly on page 98 and Database Character
Set and StarTeam Server on page 99.
7. Create a StarTeam server configuration. For more information, see Creating and Starting a Server
Configuration with an Oracle Schema User on page 100 (about automatically created schema users) and
Overview of Creating the Oracle Schema User Manually on page 104.
Caution:
After you have started using StarTeam with Oracle, remember:
•
•

Never modify the database contents other than through a StarTeam client or Server Administration
tool. Direct database manipulation is unsupported.
Never modify vault files other than through a StarTeam client or a Server Administration tool.

Verifying Connectivity Between Client and Server
If Oracle Client and Oracle Server are located on different computers (as recommended), verify that Oracle
Client can connect with the Oracle database instance. This ensures that a StarTeam server configuration can
access the Oracle schema user.
To verify the connection between Oracle Client and Oracle Server:
1. Using Oracle Client on the StarTeam Server computer, set up Oracle connectivity.
2. Use Net Configuration Assistant to establish the connectivity between the computers on which Oracle Client
and Server are installed.
3. Test the database connectivity through SQL*Plus or SQL*Worksheet.

Creating a Server Configuration for an Oracle Schema User
The first time you start a new server configuration, StarTeam Server creates all the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time.
Before you begin, you need to know:
•
•
•

The Oracle Database Server name and either the Oracle Service name or SID
The system password
The logon name and password for the schema user

To create a server configuration:
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1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
a) Type the name of the configuration in the Configuration Name text box.
b) Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
c) Select Oracle from the Database Type drop-down list box.
d) Clear the option to Create new StarTeam database, so that StarTeam Server does not automatically
create the tablespace and schema user for the schema user.
e) Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

f) Click Next. The Database Information page of the wizard opens.
g) Type the Database Server name in the Database Server name field.
h) If you are not using the default port, check Edit Database Port check box and type the port number in
the text field.
i) Type the login name and password for the schema user in the appropriate field.
j) Select either Service Name or SID and provide the information in the appropriate field.
k) Click Verify Connection to be sure that you can successfully access the schema user.
l) Click Finish.
This action re-displays the Server Administration window, which shows your new server configuration as
a child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about
this file, see StarTeam Help or the StarTeam Server Help guide which are both accessible from the
Borland StarTeam ➤ StarTeam Cross-Platform Client <version> ➤ Documentation submenu.
These documents explain the file options and how to set them from the command line.

Installing Oracle Client
Oracle Client is required to use Oracle withStarTeam. A list of choices for various operating systems is available
at: http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html
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Select See All for Windows 32 bit or Windows x64 to display downloads specific to that OS. Install the driver
that matches the version of StarTeam that you plan to use (32 or 64 bit). Choose Oracle Database 11g Release
2 Client.
During the Oracle Client installation, there are various options. StarTeam only requires the Instant Client.
Most Oracle installation packages (Universal Installer, SQL Developer) install the appropriate Oracle drivers
on a given system. If you have already installed these products, it is likely that no other Oracle driver related
installation is necessary.

Using NLS_LANG Correctly
StarTeam Server converts data that is stored in the database to UTF-8 format. Your database character set
should be defined such that it will not conflict with this nor with other StarTeam Server requirements. For more
information, see Defining NLS_LANG in the Windows Registry on page 99.
NLS_LANG represents the Oracle Client character set. The Oracle Client character set is defined by the third
part of the NLS_LANG parameter and must be set to a value that Server uses.
After setting NLS_LANG correctly, Oracle Client correctly translates any symbols to the character code values
of the database character set when storing data into the database or retrieving data from the database.
NLS_LANG is specified in the following format.
NLS_LANG = language_territory.characterset
where:
language
specifies the language used for Oracle messages, day names, and month names.
territory
specifies the monetary and numeric formats, territory, and conventions for calculating week and day numbers.
characterset
controls the character set used by Oracle Client. (Normally it matches your Windows code page.)

Overview of Defining NLS_LANG
The ODBC installation supports multiple Oracle homes. Each ODBC driver is uniquely identified by the name
of the Oracle home in which it is installed. Applications using Oracle ODBC drivers use the value of NLS_LANG
for making decisions related to character set conversion. The character set portion of the NLS_LANG setting
must be AMERICAN_AMERICA.WE8MSWIN1252. If your StarTeam database was previously Oracle 8i, then
you use AMERICAN_AMERICA.WE8ISO8859P1.
The ODBC driver installation uses the value of the Windows code page (ACP) and defines the value of
NLS_LANG in the registry. The value of NLS_LANG should be verified for accuracy. Be sure to check for the
NLS_LANG environment variable because it will override the registry setting. You may choose to delete the
variable. For more information, see Defining the NLS_LANG as an Environment Variable on page 99.
You can define NLS_LANG for the Oracle Client in either of the following ways:
•

In the Registry (Windows only)
For more information, see Defining NLS_LANG in the Windows Registry on page 99.
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Oracle Client and Server support the concept of multiple Oracle homes. What this means is that you can
have multiple sets of Oracle binaries on the same computer. When you have multiple Oracle homes on the
same computer, you have multiple registry entries for each home. NLS_LANG should be defined for each
home.
•

As an environment variable
For more information, see Defining the NLS_LANG as an Environment Variable on page 99.
Although the Registry is the primary repository for environment settings, it is not the only place where
environment parameters can be set.You can set the NLS_LANG as a System or User Environment Variable
in the System properties.
Caution: If NLS_LANG is defined as an environment variable, it will be used for all Oracle homes.
This option should be used with caution, especially for cases where there are multiple Oracle homes
on the computer and some Oracle homes have different NLS_LANG settings. It may be best to delete
it.

Defining NLS_LANG in the Windows Registry
Note: If NLS_LANG is not defined, it defaults to AMERICAN_AMERICA.US7ASCII and must be changed
to a value that Server uses.
To change the NLS_LANG setting using the Windows Registry Editor:
1. From the Windows Start menu, choose Start ➤ Run. The Run dialog box opens.
2. Type regedit, and then click OK.
3. Edit the following registry entry: HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\homeID
where homeID is the unique name identifying the Oracle home.

Defining the NLS_LANG as an Environment Variable
Note: If NLS_LANG is not defined, it defaults to AMERICAN_AMERICA.US7ASCII and must be changed
to a value that Server uses.
To create or modify the NLS_LANG environment variable’s setting on Windows:
1.
2.
3.
4.

Right-click the My Computer icon on your desktop, and then choose Properties from the context menu.
Select the Advanced tab.
Click Environment Variables. The Environment Variables dialog box opens.
Select NLS_LANG and define an appropriate value.
To create or modify this setting for LINUX, define the value of NLS_LANG in the .profile or .cshrc file.
Contact your LINUX Admin to learn how to set environment variables.

Database Character Set and StarTeam Server
StarTeam Server stores UTF-8 data in Oracle schema users. StarTeam Server does not use the Oracle
conversion mechanism. It performs the conversion to UTF-8 itself.
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Caution: Because StarTeam Server does the conversion, it is very important to prevent Oracle Client
from also converting the data. A double conversion will result in garbage.
Oracle software does the conversion only when the Oracle Client’s character set (specified by NLS_LANG)
does not match the database instance’s character set. Therefore, it is very important that the client and server’s
settings match. StarTeam server configurations require that Oracle database instances use the WE8MSWIN1252
character set. If your StarTeam database was previously Oracle 8i, then Oracle database instances use the
WE8ISO8859P1 character set.
The Server Administration tool does not allow you to create a new StarTeam server configuration unless the
underlying database instance’s character set is the correct character set. As StarTeam Server starts, it also
ensures that the database character set matches the characters set portion of NLS_LANG.
Due to the numeric setting differences between different languages and territories, StarTeam Server also does
not start unless AMERICAN_AMERICA (the US numeric setting) is the setting for the language_territory portion
of NLS_LANG. Failure to do so causes exceptions for StarTeam Server. This does not mean that numbers
and so on will be displayed incorrectly. For example, in Germany and other countries, a decimal point is
represented as a comma. Such numbers will still display correctly.

Creating and Starting a Server Configuration with an Oracle
Schema User
The first time you start a new server configuration, StarTeam Server creates all the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time. It assumes that you want StarTeam Server to automatically create the Oracle tablespace and a
schema user named StarTeam. If that is not the case, see Overview of Creating the Oracle Schema User
Manually on page 104.
For new configurations, you must know the Oracle Database Server name and either the Oracle Service name
or SID.
To create a server configuration with an Oracle schema user:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
a) Type the name of the configuration in the Configuration Name text box.
b) Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
c) Select Oracle from the Database Type drop-down list box.
d) Check the option to Create new StarTeam database, so that StarTeam Server automatically creates
the tablespace and schema user for the schema user.
e) Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
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•
•
•
•

Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

f) Click Next. The Create an Oracle Schema User page of the wizard opens.
g) Type the Oracle Server name or SID in the appropriate field.
h) If you are not using the default port, check the Edit Database Port checkbox and type the port number
in the text box.
i) Enter the database system password in the System password text box.
j) Click Verify Connection to make sure that you can properly connect to the database.
k) To keep the name of the server configuration and the schema user the same, both the New schema
user name text box default to the name you provided earlier for the server configuration. Change these
names if you prefer to use different values.
l) Enter and confirm a password for the schema user name.
m) Click Next. The Create a Tablespace for StarTeam Schema page of the wizard opens.
n) The tablespace name defaults to the name of your server configuration. Change this name if you prefer
to use a different value.
o) If you have fewer than 15 users and expect to store 1 GB or less of data, the default settings are
appropriate for your use. If you are very familiar with Oracle schema users, you may choose to alter the
names, sizes, and locations of the data files. For more information, see Guidelines for Data Files on
page 102. To avoid fragmentation, make the data files as large as possible, based on the maximum
amount of data expected in the database. Use at least three data files when creating a tablespace
because:
•
•

There is a size limit of 2 GB per data file.
Fewer files can result in slow response times when insert activity is heavy.

p) Click Finish.
The Server Administration window re-displays, showing your new server configuration as a child of the
Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about
this file, see StarTeam Help or the StarTeam Server Help guide which are both accessible from the
Borland StarTeam ➤ StarTeam Cross-Platform Client <version> ➤ Documentation submenu.
These documents explain the file options and how to set them from the command line.
4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint. To change the endpoint:
a) Select the server configuration.
b) Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
c) Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
5. Be sure to configure your new server configuration (see the StarTeam Server Help guide for more information)
and plan a backup schedule for it.
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Guidelines for Data Files
Micro Focus suggests the following guidelines for the number of data files and their sizes, based on the number
of users. Your needs may be different than those shown in the table below.
Number of Users

Number of Data Files

Size of Each Data File

Up to 15

3

50 MB

Between 15 and 50

3

300 MB

Between 51 and 100

5

300 MB

Between 101 and 300

7

500 MB

>300

7

800 MB

Running SQL Scripts for Oracle Schema Users
StarTeam Server comes with some SQL scripts written specifically for use with the Oracle schema users.
These scripts help you maintain and tune StarTeam databases. You run some SQL scripts after installation,
some on a weekly basis for database performance maintenance, and some scripts are run for you automatically
by StarTeam Server.
The SQL scripts for Oracle schema users that you may run are located in the Borland\StarTeam Server
<version>\DBScripts\Oracle_Scripts folder.
Note: The Oracle_Scripts folder contains several subfolders: Create_Stored_Procedures,
Drop_Stored_Procedures, Install, Preinstall, Generic, and DW (for Data Warehouse). The
scripts in these subfolders are run by StarTeam Server as needed. NEVER execute any of them directly
from an external database user interface, such as SQL*Plus or SQL *Worksheet.
The following table lists the SQL scripts that you are most likely to need. Some should be run manually on a
regular basis. The table recommends the frequency for running these scripts. You may adjust the frequency
depending on the StarTeam usage at your facility. Run scripts at times when the server is least used, such as
overnight or on weekends.
In addition to running these scripts, you should also run a Purge option from the Server Administration tool to
remove deleted views from the schema user. Micro Focus recommends purging the schema user after you
have deleted one or more views from a StarTeam project. See the StarTeam Server Help guide for information
on the Purge option.
StarTeam Script Name

Run Frequency

starteam_oracle_compute_stats.sql

Weekly

starteam_oracle_dropall.sql

Only if necessary

starteam_oracle_rebuild_indexes.sql

Weekly

For a description of these scripts, see StarTeam SQL Scripts for Oracle Schema Users on page 103.
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Caution: Be sure to backup your StarTeam schema user, as necessary, and verify these backups
periodically.You should restore and test backups of your StarTeam project data on a test system. Restoring
and testing your backups helps to ensure that your data is being backed up correctly.
To run a SQL script for Oracle schema users:
1. Go to the command prompt.
2. Change directories to the directory containing the StarTeam SQL scripts for Oracle schema users.
3. At the command prompt, type:
sqlplus username/password@servicename
where
username is the StarTeam Oracle Schema User Name
password is the StarTeam Oracle Schema Password
servicename is the Net Service Name created using Oracle Net 8 Easy Config
4. Execute the script. For example, to execute the starteam_oracle_compute_stats.sql script, type
@starteam_oracle_compute_stats.sql and press Enter.

StarTeam SQL Scripts for Oracle Schema Users
•

starteam_oracle_compute_stats.sql
Run: weekly.
The starteam_oracle_compute_stats.sql script updates the statistics in the database distribution page for
all tables in the database. This data enables the query optimizer to choose the right index for a given query.

•

starteam_oracle_create_check_database.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_create_check_privileges.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_create_database.sql
Run: automatically by StarTeam Server when creating a new server configuration.
This script creates a new Oracle schema user.

•

starteam_oracle_create_fix_custom_fields.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_create_upgrade_33.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_34.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_35_catalog.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_35_data.sql
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Run: automatically by StarTeam Server when upgrading a server configuration.
•

starteam_oracle_create_upgrade_36.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_55.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_58.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_database_analyze.sql
Run: weekly.

•

starteam_oracle_create_fix_dup_login_names.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_extract_ddl.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_fix_long_raw.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_dropall.sql
Run: only if necessary.
Caution: Running the starteam_oracle_dropall.sql script will delete all StarTeam tables and the data
they contain from the database. Use this script with extreme caution.
The starteam_oracle_dropall.sql script removes all StarTeam tables from the database. For example, if
you migrate a StarTeam server configuration to another database, you might use starteam_oracle_dropall.sql
to remove tables from the original database. Or if you mistakenly add the StarTeam tables to a tablespace
other than the StarTeam tablespace, use the starteam_oracle_dropall.sql script to remove them. This script
can be executed from either Sql*Plus or SQL*Worksheet.

•

starteam_oracle_get_dbinfo.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_rebuild_indexes.sql
Run: weekly.
The starteam_oracle_rebuild_indexes.sql script rebuilds the database indexes and configures the storage
parameters for the index tablespace. The script assumes that the indexes are located in a tablespace
named INDX. If your index tablespace uses a different name, edit starteam_oracle_rebuild_indexes.sql to
reflect the correct tablespace name. Run the starteam_oracle_rebuild_indexes.sql script weekly to enhance
database data retrieval.

Overview of Creating the Oracle Schema User Manually
This section explains how to manually create an Oracle tablespace and schema user for StarTeam Server. It
also provides an overview of the tuning and maintenance SQL scripts that are provided with StarTeam Server,
and explains how to use them. For detailed information on Oracle performance tuning, consult your Oracle
documentation.

104

| Using StarTeam with Oracle Databases

To configure an Oracle database instance:
1.
2.
3.
4.

Complete the procedures described in Overview of Using an Oracle Schema User on page 95.
Create a StarTeam tablespace.
Create a StarTeam schema user.
To ensure that StarTeam Server can create labels and perform other operations successfully, make sure
that the schema user has the following Oracle privileges. They must be explicitly defined rather than
relegated to roles. For more information, see Granting Oracle Privileges on page 25.
•
•
•
•
•
•
•
•
•
•

create procedure
create sequence
create session
create table
create trigger
create type
create view
unlimited tablespace
create any context
drop any context

5. Create the server configuration. For more information, see Creating a Server Configuration for an Oracle
Schema User on page 105.

Creating a Server Configuration for an Oracle Schema
User
The first time you start a new server configuration, StarTeam Server creates all the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time.
Before you begin, you need to know:
•
•
•

The Oracle Database Server name and either the Oracle Service name or SID
The system password
The logon name and password for the schema user

To create a server configuration:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
<version> ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
a) Type the name of the configuration in the Configuration Name text box.
b) Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
c) Select Oracle from the Database Type drop-down list box.
d) Clear the option to Create new StarTeam database, so that StarTeam Server does not automatically
create the tablespace and schema user for the schema user.
e) Create an initial hive for the Native-II vault by doing one of the following:
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•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

f) Click Next. The Database Information page of the wizard opens.
g) Type the Database Server name in the Database Server name field.
h) If you are not using the default port, check Edit Database Port check box and type the port number in
the text field.
i) Type the login name and password for the schema user in the appropriate field.
j) Select either Service Name or SID and provide the information in the appropriate field.
k) Click Verify Connection to be sure that you can successfully access the schema user.
l) Click Finish.
This action re-displays the Server Administration window, which shows your new server configuration as
a child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about
this file, see StarTeam Help or the StarTeam Server Help guide which are both accessible from the
Borland StarTeam ➤ StarTeam Cross-Platform Client <version> ➤ Documentation submenu.
These documents explain the file options and how to set them from the command line.
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Understanding Data Locations
As part of creating a new server configuration, StarTeam Server creates a number of folders for storing log
files, archive files, and so on. This section explains the location and purpose of the files and folders that make
up the StarTeam vaults and repositories.

Understanding Repositories
The following figure shows the server configuration whose repository path starts with a drive letter (not shown
in figure) and ends with the folder name MyConfiguration.

The name of the server configuration may also be MyConfiguration.
The repository path is a general location for initial storage of a variety of objects, most of which can be moved
to new locations later, independent of one another.

Native-II Vault Folders
For server configurations, whether newly created in or upgraded to StarTeam Server 2005 or a later release,
the repository path is also the initial home of several folders used by the Native-II Vault to store archive files
and information about them:
•

Default Hive
If you accepted all the defaults when you created the server configuration or if you started an upgraded
server configuration without first creating a hive, StarTeam Server automatically creates the folder
DefaultHive. It is a subfolder of the repository path and is created when you start the server configuration
for the first time.

Whether the initial hive is called DefaultHive or not, you will have at least one hive for each server
configuration. You may have several hives. Each hive has an archive and cache path. An easy, but not
mandatory, naming convention is the one illustrated in the above figure. The name of the hive becomes
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the name of a folder with two subfolders: Archives and Cache. However, you can place these paths anywhere.
They do not need to be on the same drive or volume.
The DefaultHive subfolders have the following purposes:
•

Archives
This folder stores file revisions in archive files, which may be compressed.

•

Cache
This folder stores uncompressed versions of archive files. It has two subfolders Temp and Deltas. Temp
is used for files that are being added to StarTeam and for new file revisions that are being checked in.
Deltas stores the differences between working files and tip revisions when a user asks that transmissions
over slow connections be optimized.

You can use the Hive Manager to change an individual hive’s archive path and/or cache path. Such changes
should be done only when that hive must be moved. For example, you might move a hive as a result of a
drive failure. You would also need to copy the contents of the hive’s archive path to the new location.
The archive path for any hive must be included in a backup. A hive’s cache path does not need to be
included. For more information, see Archive and Cache Path Structure on page 108.
•

HiveIndex
If you have started a 2005 or later server configuration, it has at least one hive. The HiveIndex folder stores
the hive-index.xml file, which contains the properties for each hive used by the server configuration.
You can change the path to the HiveIndex folder by changing the repository path in the
starteam-server-configs.xml file. You would make this change only when necessary, for example, because
of a drive failure.
The HiveIndex folder must be included in a backup. For more information, see Archive and Cache Path
Structure on page 108.

Archive and Cache Path Structure
Every hive's archive path and cache path has the same structure. This structure is similar to that used by
StarTeam clients to store file status records. The files located in the archive and cache are organized into
subfolders. This makes browsing and managing the files easier. The name of the subfolders in which a file
revision is stored is based on the initial characters in the archive file's name. For example, suppose a file
revision's contents has an MD5 value of 01fc3c4ac5e0e92cc707f30fb73a0726. Assuming the user
specified an archive path of C:\DefaultHive\Archives the archives path for this revision would be one
of the following, depending on whether or not the archive file was compressed:
C:\DefaultHive\Archives\01\f\01fc3c4ac5e0e92cc707f30fb73a0726
C:\DefaultHive\Archives\01\f\01fc3c4ac5e0e92cc707f30fb73a0726.gz
The figure below shows the path from an Archives folder to an archive file.
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The archive path for each hive (for example C:\DefaultHive\Archives) must be included in a backup.
See the StarTeam Help or the StarTeam Server Help guide for more information.

Log Files and Folders
The repository path folder becomes the home of the following related objects.
•

The server log files
A new server log file is created each time you start the server configuration. See the StarTeam Server Help
guide for more details about server logs.

•

Any .dmp files created when you use server diagnostics to create .dmp files for errors and unexpected
conditions encountered by the server.
Usually, you have no .dmp files or trace files unless a Micro Focus technical support representative is
working with you on a problem. See the StarTeam Server Help guide for more details about server
diagnostics.

•

The Notifications folder
When a server configuration starts for the first time, the contents of the Notifications folder in the installation
directory are copied to the repository for the server configuration in a corresponding Notifications folder.

•

The Trace folder
The Trace folder stores the files that are created when and if you use server diagnostics to trace server
commands. See the StarTeam Server Help guide for more details about server diagnostics.

Understanding Data Locations

| 109

These objects do not have to remain in the repository path. You can change the path to all of the above by
changing the Log Path using the Server Administration tool. See the StarTeam Server Help guide for more
information.
These folders do not have to be included in a backup.
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Installing and Configuring Supporting
Software
This appendix provides information about software that you use in conjunction with StarTeam:
•
•
•

Synchronizing workstation clocks
Adobe Acrobat Reader
Java runtime environment

Synchronizing Workstation Clocks
The computers that run application clients and the Server must have their dates and times synchronized. Many
features of the application depend on calculations involving times and dates. In particular, labels, configurations,
and promotion states are all governed by time and date calculations.
Important: If the client and server are not kept synchronized, a number of operations (such as checkout,
file status displays, or label creation) might fail or produce inaccurate results.
Therefore, you should use whatever service your network server supports for synchronizing all workstation
clocks. For example, Windows network users can execute the following command to synchronize their
workstation time with the computer on which the Server is installed:
net time \\server_name /set /yes
In this example, you would replace server_name with the machine name or IP address of the network
computer running the Server.

Adobe Acrobat Reader
The primary documentation for the StarTeam product line is delivered in Adobe’s Portable Document Format
(.pdf), and can be viewed with version 7.0 or later of Adobe’s free Acrobat Reader. You can download the
latest version of the Acrobat Reader from Adobe’s web site at http://www.adobe.com.

Installing the Java Runtime Environment
The application client and server installation programs automatically install a Sun Microsystems Java Virtual
Machine on your computer if the required version is not already installed.
Java requires a minimum of 256 colors to start any AWT or Swing-based graphical user interface. When you
try to start the Server from the Windows Start menu on a computer with too few colors, you see a DOS box
blink on the screen then go away.
The StarTeam Cross-Platform Client installer runs the Sun tzupdater program on the Sun JRE (1.6.0_29)
installed with this release. The tzupdater program changes the JRE in order to provide better DST (Daylight
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Savings Time) information for Eastern, Mountain, and Hawaiian time zones. It also deletes three JRE files
from the lib/zi folder (if they are there): EST, HST, MST.
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Backing Up Databases
This chapter outlines the backup options available to DBAs and makes recommendations for backing up the
databases used by the server configurations. Be aware that these are just recommendations. Any finalized
disaster recovery plan must be created by your organization in consultation with its IT infrastructure staff.
An application backup consists of backing up both the database and the application archive files. Starting with
StarTeam Server 2005, you have a choice between online and offline backups. If all of your archive files are
in Native-II format, you can back up a server configuration online—without shutting it down or locking it. If your
have a pre-2005 StarTeam Server release, you must convert older archives from Native-I to Native-II format
prior to performing an online backup. Regardless of the Server release, you must also set up your database
for an online backup.

Backing Up SQL Server Databases
For server configuration online backups, it is essential to take full database and transaction log backups.
SQL Server supports the following types of backups:
•

Full database backup
A full database backup contains the full copy of the database as it was at the time when the backup was
initiated. Full backups provide a snapshot of the database. Most of the recovery options require a full backup
to be available.

•

Differential backup
A differential database backup records only the data that has changed since the last full database backup.
Scheduling frequent differential backups is a good idea because the backups are smaller and they complete
quickly. A differential backup without a prior full backup is useless.

•

Transaction log backup
A transaction log backup includes all the transactions since the last transaction log backup. Transaction
log backups enable recovery up to the last committed transaction.

•

A file or file group backup
A file or file group backup consists of backing up individual data files (or the files in the file group). The files
in a database can be backed up and restored individually.

The entire database can be recreated from a database backup in one step by restoring the database. The
restore process overwrites the existing database or creates the database if it does not exist. The restored
database will match the state of the database at the time the backup completed, minus any uncommitted
transactions. Uncommitted transactions are rolled back when the database is recovered.
Based on the resource requirements, the DBA can also choose the recovery model for the database. The
recovery model balances logging overhead against the criticality of fully recovering the data.
The recovery models supported by SQL Server are:
•

Full
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The data is critical and must be recoverable to the point of failure. All data modifications are logged. All
SQL Server recovery options are available.
•

Bulk-logged
Certain bulk operations, such as bulk copy operations, SELECT INTO, and text processing, can be replayed
if necessary, so these operations are not fully logged. You can recover only to the end the last database
or log backup.

•

Simple
All data modifications made since the last backup are not available. This type of recovery scenario has the
lowest logging overhead, but cannot recover past the end of the last backup.

Recovering to a point-in-time (for example, a time before unwanted data was entered) requires either full or
bulk-logged recovery models.

Full Database Backup
A full database backup creates a duplicate of the data that is in the database. This is a single operation, usually
scheduled at regular intervals. Full database backups are self-contained. Full backups provide a snapshot of
the database. Most of the recovery options require a full backup to be present.
Micro Focus strongly recommends the use of full backups.

Differential Database Backup
A differential database backup records only the data that has changed since the last database backup. Frequent
differential backups are recommended to reduce backup times. Making frequent backups decreases the risk
of losing data.
Differential backups restore the data that they contain to the database. Differential backups cannot be used
to recover the database to a point in time.
The availability of a differential backup minimizes the time it takes to roll forward transaction log backups when
restoring a database.

Transaction Log Backups
The transaction log is a serial record of all the transactions that have been performed against the database
since the transaction log was last backed up. With transaction log backups, you can recover the database to
a specific point in time or to the point of failure.
When restoring a transaction log backup, SQL Server rolls forward all the changes recorded in the transaction
log. When SQL Server reaches the end of the transaction log, it has re-created the exact state of the database
at the time of the backup operation.
If the database is recovered, SQL Server then rolls back all transactions that were incomplete when the backup
operation started. Transaction log backups generally use fewer resources than database backups. As a result,
you can create them more frequently than database backups. Frequent backups decrease the risk of losing
data. For high volume Online Transaction Processing (OLTP) environments, it is desirable to create transaction
log backups more frequently.
Transaction log backups can only be used with Full and bulk-logged recovery models.
The transaction log cannot be backed up during a full database backup or a differential database backup.
However, the transaction log can be backed up while a file backup is running.
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Never backup a transaction log before a database backup is created because the transaction log contains the
changes made to the database after the last backup was created.
Never truncate the transaction log manually because it breaks the backup chain. If a transaction log has been
truncated, take a full database backup to start a new backup chain.

File Backups
A file or file group backup consists of the backing up of individual data files (or the files in the file group). A
file-based recovery model increases the speed of recovery by allowing you to restore only the damaged files
without restoring the rest of the database. For example, suppose a database is comprised of several files
located physically on different disks and one disk fails. Only the file on the failed disk needs to be restored and
rebuilt using the transaction log backup.
File backup and restore operations must be used in conjunction with transaction log backups. For this reason,
file backups can only be used with the full recovery and bulklogged recovery models.

Recommendations
Micro Focus recommends that you:
•
•

•

Use the full recovery model
Perform a full database backup once every day. For full database sizes greater than 3 GB, it is okay to
perform full backups on alternate days. If you perform full backups on alternate days, Micro Focus strongly
recommends that you create daily differential backups.
Create daily transaction log backups after the completion of the full or differential backup.
In addition to this, schedule a transaction log backup every 4 hours.
Never truncate a transaction log manually.

•

In case of a disaster, create a backup of the currently active transaction log.
If active transaction log backup is not available (for example, because a media failure for the drive hosting
the transaction logs and drive is not being mirrored), the database cannot be recovered past the last available
transaction log backup. This would hamper a point-in-time recovery beyond the last available transaction
log backup.

•
•

Label the backup tapes correctly.
Keep backup copies in offsite locations.

Backing Up Oracle Databases
An online or hot backup is a backup performed while the database is online and available for read/write
operations. Except for Oracle exports, you can only perform online backups when running in ARCHIVELOG
mode. An offline or cold backup is a backup performed while the database is offline and unavailable to its
users.
Typically an Oracle DBA uses one or more of the following options to back up an Oracle database.
•

Export/Import
Exports are “logical” database backups that extract logical definitions and data from the database to a file.
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Export backups are cross-platform and can be easily moved from one operating system to the other.
•

Cold or Offline Backups
These backups require shutting down the database instance and copying all the data, log, and control files.

•

Hot or Online Backups
These backups are taken when the database is available and running in ARCHIVELOG mode. To perform
a backup of this type, the tablespaces need to be in backup mode and all the data files associated with the
tablespace must be backed up. It is essential to backup the control files and archived redo log files.

•

Recovery Manager (RMAN) Backups
While the database is offline or online, DBAs can use the RMAN utility to back up the database.

•

Export/Import Data Pump
Export pump and import pump are new for Oracle 10g. Expdp and Impdp are crossplatform and can be
easily moved from one OS to the other.

Logical Backups (Export/Import)
Oracle exports are “logical” database backups (not physical) as they extract data and logical definitions from
the database into a file. Other backup strategies normally back up the physical data files. One of the advantages
of exports is that you can selectively re-import tables. However, you cannot roll forward from a restored export
file. To completely restore a database from an export file, you almost need to recreate the entire database.
Logical backups takes a snapshot of the database schema as it was at a particular time.

Offline/Cold Backups
A backup performed when the database is shut down is known as an offline or cold backup. You must copy
the data files, control file and online redo log files using an OS copy utility. This is a considered a complete
backup of the database. Any changes made after this backup are unrecoverable if the database is running in
NOARCHIVELOG mode. All transactions are recorded in online redo log files whether the database is archiving
or not. When redo logs are archived (ARCHIVELOG mode), ORACLE allows you to apply these transactions
after restoring files that were damaged (assuming that an active redo log file was not among the files damaged).
Whenever the schema of the database is changed, such as when you add a new data file, rename a file, or
create or drop a tablespace, you must shut down the database and copy at least the control file and the newly
added data file. A complete backup of the database is preferred.
Before performing a cold backup, it is essential to get a list of all the Oracle files that need to be backed up.
Running the following queries will provide a list of all the files.
select name from sys.v_$datafile;
select member from sys.v_$logfile;
select name from sys.v_$controlfile;
Shut down the database from SQL*Plus or Server Manager. Back up all the files to secondary storage (for
example, tapes). Ensure that you back up all data files, all control files, and all log files. When completed,
restart your database.
Note: If your database is in ARCHIVELOG mode, you can still use archived log files to roll forward from
an offline backup. If you cannot take your database down for an offline backup at a convenient time, switch
your database into ARCHIVELOG mode and perform an online backups.
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Online/Hot Backups
A backup performed when the database instance is running is known as online or hot backup. Online backups
are very important at customer sites where a database instance must operate 24-hours per day and offline
backups are not feasible. During the duration of an online backup, the database remains available for both
reading and updating. For this kind of backup, the database must be in ARCHIVELOG mode. Only data files
and current control files need to be backed up. Unlike offline backups, the unit of a online backup is a tablespace,
and any or all tablespaces can be backed up whenever needed. Different data files can be backed up at
different times.
To perform an online backup, you switch the tablespace into “backup mode” before copying the files as shown
in the following example.
ALTER TABLESPACE xyz BEGIN BACKUP;
! cp xyfFile1 /backupDir/
ALTER TABLESPACE xyz END BACKUP;
It is better to backup individual tablespaces than to put all tablespaces in backup mode at the same time.
Backing them up separately incurs less overhead. After completing the tablespace backups, it is important to
back up the control files as shown in the following example.
ALTER SYSTEM SWITCH LOGFILE; --Force log switch to update control file headers
ALTER DATABASE BACKUP CONTROLFILE TO '/directory_name/control.dbf';
The frequency of online backups is inversely proportional to the time taken for recovery in case of a media
failure. The older your backup, the more redo log files need to be applied, and the recovery times increases.
Backup strategies should be tested before being used to protect a production database.
Micro Focus strongly recommends that you run online backups at times when the database is least accessed,
during non-peak hours. Oracle writes complete database blocks instead of the normal deltas to redo log files
while in backup mode. This leads to excessive database archiving and could lock up the database.

RMAN Backups
Recovery Manager (RMAN) is an Oracle tool that lets the DBA back up and recover Oracle databases. RMAN
lets you perform full backups (with the database online or offline), incremental backups on the block level, and
backups of online redo logs and control files.
The SYSDBA privilege is required to run RMAN on a database. The other benefits of RMAN backups are that
you can:
•
•
•
•
•

Keep track of all backup and recovery operations performed against the database.
Manage centralized backup and recovery procedures for the enterprise.
Identify corrupt blocks.
Back up only those blocks that actually contain data. This can lead to significant savings in backup space
requirements.
Have support for incremental backups.
Incremental backups back up only those blocks that have changed since a previous backup. This helps
with the disk space usage and reduces the backup times significantly.
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Oracle 10g has introduced a new feature called “block change training”. This feature provides significant
improvement for incremental backups. Contact your DBA about how to implement this feature.
The following examples of RMAN backup and restore are extremely simplistic and are included on to illustrate
basic concepts. By default, Oracle uses the database control files to store information about backups. Normally,
you will prefer to set up an RMAN catalog database to store RMAN metadata. Read the Oracle Backup and
Recovery Guide before implementing any RMAN backups.
rman target sys/*** nocatalog
run {
allocate channel t1 type disk;
backup
format '/app/oracle/db_backup/%d_t%t_s%s_p%p'
( database );
release channel t1;
}
Example RMAN restore:
rman target sys/*** nocatalog
run {
allocate channel t1 type disk;
restore tablespace users;
recover tablespace users;
release channel t1;
}

Export/Import Data Pump
Oracle introduced the export/import data pump in the 10g release. The import pump is twenty times faster than
the conventional import utility. Export/Import data pump utilities are “logical” database backups (not physical)
as they extract data and logical definitions from the database into a file. Export/Import data pump utilities do
not fit into 24/7 model because they do not offer roll-forward capabilities. Export data pump provides a snapshot
of the database schema as it was at a particular time.

Recommendations
Micro Focus strongly recommends the use of RMAN backups if your enterprise wants to run a StarTeam
instance in a 24/7 environment. RMAN has evolved over the last few years and Oracle Corporation continues
to add features that make disaster recovery easier, more reliable, and faster.
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Oracle Database Tuning
This section provides the basic information needed to create an Oracle schema for StarTeam Server. Micro
Focus recommends using the Administration tool to create the schema, but if you prefer to create your own,
follow the guidelines provided in this section.

Recommended Initialization Parameters
The following two tables recommend Oracle parameter settings for use with StarTeam databases.
Parameter

Recommended Value

Compatible

•
•

10gR2: 10.2.0
11g: 11.1.0.0.0

Cursor_sharing

•
•

10gR2: Force
11g: Force

Log_checkpoint_interval

Greater than the redo log size

Log_checkpoint_timeout

0

Workarea_size_policy

Auto

Db_block_size

16384 (16k)

Db_file_multi_block_read_count

16

Optimizer_mode

first_rows

Timed_statistics

True

Open_cursors

400

Undo_management

Auto

Undo_tablespace

(Name of the undo tablespace)

Undo_retention

28800

Processes

250

Statistics_level

Typical

Table 1: Common Database Configuration Parameters
Total Memory

Recommended 10gR2 Settings

Recommended 11g Settings

1 GB

SGA_TARGET = (Total Physical
Memory * 80%) * 60%

MEMORY_TARGET = Total Physical
Memory * 75%

We assume that 20% of the total
memory will be used by the OS.

We assume that 20% of the total
memory will be used by the OS and that
the Oracle instance is running on a
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Total Memory

Recommended 10gR2 Settings

Recommended 11g Settings

Statistics level should be TYPICAL or
ALL.

dedicated machine. Statistics level
should be TYPICAL or ALL.

LOG_BUFFER = 524288

LOG_BUFFER = 524288

PGA_AGGREGATE_TARGET = (Total
Physical Memory * 80%) * 30%
30% of the non-OS available memory.
This is the starting value.This may need
to be adjusted upwards.
2 GB

SGA_TARGET = (Total Physical
Memory * 80%) * 60%

MEMORY_TARGET = Total Physical
Memory * 75%

We assume that 20% of the total
memory will be used by the OS.
Statistics level should be TYPICAL or
ALL.

We assume that 20% of the total
memory will be used by the OS and that
the Oracle instance is running on a
dedicated machine. Statistics level
should be TYPICAL or ALL.

LOG_BUFFER = 1048576
PGA_AGGREGATE_TARGET = (Total
Physical Memory * 80%) * 30%

*LOG_BUFFER = 1048576

We assume that 20% of the total
memory will be used by the OS. This is
the starting value. This may need to be
adjusted upwards.
4 GB

SGA_TARGET = (Total Physical
Memory * 80%) * 60%

MEMORY_TARGET = Total Physical
Memory * 75%

We assume that 20% of the total
memory will be used by the OS.
Statistics level should be TYPICAL or
ALL.

We assume that 20% of the total
memory will be used by the OS and that
the Oracle instance is running on a
dedicated machine. Statistics level
should be TYPICAL or ALL.

LOG_BUFFER = 1048576
PGA_AGGREGATE_TARGET = (Total
Physical Memory * 80%) * 30%

LOG_BUFFER = 1048576

We assume that 20% of the total
memory will be used by the OS. This is
the starting value. This may need to be
adjusted upwards.

Table 2: Database parameters based on total memory

Oracle Database Monitoring and Tuning
The most efficient way to tune your oracle database is to start with the recommended database settings and
monitor the instance using the advisories. In addition to that, Micro Focus recommends the use of Automatic
Workload Repository (AWR) to collect performance statistics, including wait events used to identify performance
problems. A detailed description of AWR is beyond the scope of this document. Please refer to your Oracle
10g performance tuning guide for more information.
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Oracle 10gR2 Databases
This section provides information about tuning Oracle 10g databases.

Automatic Shared Memory Management
Oracle 10g introduced Automatic Shared Memory Management (ASMM) of individual SGA components like
shared pool, java pool, large pool and db cache. You do not need to estimate when setting the size of SGA
components. In fact, there is no need to set any parameters defining SGA size.
All you have to do is to set a new parameter called SGA_TARGET. The parameter SGA_TARGET takes a
value which indicates the maximum size of SGA required for your instance.
Consider that you set SGA_TARGET to say 800MB. This indicates that maximum size to which SGA can grow
is 800MB. All the SGA components like shared pool, buffer cache, large pool, java pool will be allocated from
this 800M maximum SGA. Oracle will automatically calculate the initial size of these components and resizes
it as per the requirement without any manual intervention.
You do not have to explicitly define values for shared pool, buffer cache, large pool and java pool if you set
SGA_TARGET. The SGA_TARGET will be limited by the SGA_MAX_SIZE value. The SGA_MAX_SIZE cannot
be modified dynamically. If SGA_MAX_SIZE is not set, both the parameters have the same value and it will
be not possible to increase the size of SGA_TARGET dynamically.

Automatic Segment Space Management
The Automatic Segment Space Management (ASSM) feature allows Oracle to use bitmaps to manage the
free space within segments. The bitmap describes the status of each data block within a segment with respect
to the amount of space in the block available for inserting rows. The current status of the space available in a
data block is reflected in the bitmap allowing Oracle to manage free space automatically with ASSM.
ASSM tablespaces automate freelist management and remove the ability to specify PCTUSED, FREELISTS,
and FREELIST GROUPS storage parameters for individual tables and indexes created in ASSM tablespaces.
The values for parameters PCTUSED and FREELISTS are ignored and Oracle automatically manages the
space for these tables and indexes inside the tablespace using bitmaps. PCTFREE can still be specified and
is used with ASSM.

Oracle 11g Databases
This section provides information about tuning Oracle 11g databases.

Automatic Memory Management (AMM)
Beginning with version 11g, the Oracle database can automatically manage the SGA memory and the instance
PGA memory. You only need to designate the total memory size to be used by the instance, and the Oracle
database will dynamically exchange memory between the SGA and the instance PGA as needed to meet
processing demands. This capability is referred to as automatic memory management. With this memory
management method, the database also dynamically tunes the sizes of the individual SGA components and
the sizes of the individual PGAs.

Oracle Database Tuning
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AMM is implemented using Memory_Target and Memory_max_target parameters. Use of
MEMORY_MAX_TARGET is optional. When MEMORY_MAX_TARGET is not set, Oracle automatically sets
MEMORY_MAX_TARGET to the value of MEMORY_TARGET.
To switch to AMM, define the value of MEMORY_TARGET in the spfile. It is important to ensure that the values
of SGA_TARGET and PGA_AGGREGATE_TARGET are set to 0. Customers upgrading to 11g instance must
set the value of SGA_TARGET and PGA_AGGREGATE_TARGET to 0.
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